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1 Introduction

1.1 CCHE2D Graphical User Interface

CCHE2D-GUI, developed at the National Center for Computational
Hydroscience and Engineering (NCCHE), is a graphical user environment for the
CCHE2D model that facilitates boundary and initial conditions prescription for
flow and sediment simulation, mesh editing, data probing and extraction, and
visualization of the flow and sediment simulation results. The CCHE2D model is
a two-dimensional, depth-averaged, unsteady, turbulent flow model with non-
uniform and non-equilibrium sediment transport capabilities. The model has three
different turbulent closure schemes for variety of flow conditions and level of
accuracy. The model can handle wetting and drying and allows the user to specify
total slip, no slip, or log-law conditions at no-flow boundaries. This manual serves
as a guide to using the CCHE2D-GUI. In addition, the manual describes in detail
the format of the files used and produced by the CCHE2D model.

1.2 Using The Manual

This manual includes a detailed description of the capabilities of CCHE2D-GUI.
The manual explains in detail each of the option under the menus and sub-menus.
The technical details about the CCHE2D flow and sediment transport model are
provided in the accompanying technical reports. These reports should be
consulted for issues related to mesh size, time step selection, variation in spatial
discretization of non-uniform mesh, selection of turbulent closure scheme,
selection of depth criteria for distinguishing between wet and dry nodes, sediment
size classes, initial bed material composition, etc.
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1.3 Conventions

The menus, sub-menus, title of the dialog boxes, and options available in the pop
up windows are written in italic. A “—=>” symbol is used to show the selection of
sub-menu under a main menu, e.g., a=>b means select (click) b in a menu a. The
expression, select a button or select an option means select the item by positioning
the mouse pointer over the item and click the left mouse button.

Note: Both the CCHE2D model and the CCHE2D-GUI uses SI units only.



2 Getting Started

2.1 Introduction

=4 No File Selected - CCHEZD-GUI o ] [

File rid AssignBC  Wiew Skyle Data  Flowvisualizaktion  SedimentWisualization  Help

D& H | S| 2 |[Noting to select FlEl2 o @0 EEE|EE| T )

Ready I S
Fig. 2.1 CCHE2D main window

The GUI can be started by selecting the Start=>Program—>CCHE2D-
GUI> CCHE2D-GUI option from the desktop. A window labeled as CCHE2D-
GUI will appear. The CCHE2D-GUI window, shown in Fig. 2.1, is used for direct
graphical interaction with the spatial information. The window consists of a title
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bar that contains CCHE2D-GUI icon, the case name if one is selected (otherwise
“No File Selected” will appear in the title bar), and the application name
“CCHE2D-GUTI”, a menu bar, a tool bar, a status bar at the bottom, and a CAD
window.

The drop down menus in the menu bar control the CCHE2D-GUI window or give
user access to dialog boxes for mesh editing, initial and boundary conditions
specification, data probing, parameter input, and visualization of simulated
results. The menu bar, second row from the top, contains File, Grid, AssignBC,
View, Style, Data, FlowVisualization, and SedimentVisualization menus. As the
user holds the pointer over an option in the pull down menu, the status bar at the
bottom (that displays “Ready” by default) shows the tool tip. The tool bar, third
row from the top, shows some of the most commonly used options in the menus
in a graphical form. The tool bar also contains a drop down selection list that
contains a list of options that are currently available for display. In the above
figure the list box shows “Nothing to Select” as nothing is available for display. If
the user holds the cursor on any tool in the tool bar, its type will be displayed just
below the tool and the tool tip will appear in the status bar. The status bar, besides
displaying the tool tip, displays information about the node closest to the current
mouse position. The information contains values for I- and J-indices, x- and y-
coordinates, and the variable being visualized. The CAD window is used to
display the mesh with the boundary conditions or the simulation results.
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&= No File 5elected - CCHEZD-GUI
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S

Fig. 2.2 Opening an existing mesh
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If a grid or finite element mesh has already been generated, it can be loaded by
selecting the File>Open Geometry option from the menu bar as shown in Fig.
2.2. A window titled Open a Geometry File, also shown in Fig. 2.2, will pop up
prompting the user to select a geometry file. The geometry or mesh file has a
“.geo” extension, and this is the only file type that will be visible to the user. If a
mesh file exists, the user can open it by double clicking on the file or by selecting
the file and then pressing the Open button. The File menu also shows the four
most recently visited files and the user can open a geometry file by selecting one
from them.

Fig. 2.3 shows an image corresponding to a geometry file Contraction.geo. The
currently displayed variable, which in this case is bed elevation, is displayed in
the drop down list. The user can also display initial water surface level, roughness
coefficient, or grid only by selecting an appropriate variable from the drop down
list provided in the tool bar. The status bar shows mesh, spatial, and displayed
variable information of the node closest to the current cursor position.

4 Contraction - CCHEZD-GUI
File Grid AssignBC View Style Data Flowvisualization SedimentVisualization Help
O E & % |BedEevation e | o0 D|ﬁ|T|L_1.IZI|
[ruitial Bed Elewation (ro) T 7 1T
-0.050 -0.02% 0000 0025 0.050
Ready [, 3, %, v, war = 3, 5, 2.000000, 1,666667, 0000000 4

Fig. 2.3 Mesh in the CAD window
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In Fig. 2.3, both the legend and the title are added to the displayed image. The
user can add legend and title by selecting View—> Legend and View-> Title options.
As the title and legend are added, a check mark is placed beside the Legend and
Title options in the View menu.

2.2 Mesh Generation

The first step in getting a case ready for simulation is to generate a mesh for the
domain of interest. A mesh file, a file with a “.geo” extension, is required by both
the CCHE2D-GUI and the CCHE2D model. A mesh generation program with its
own interface and user’s manual is available to the users. The users can download
it from the NCCHE web site. The CCHE2D-GUI installation CD also contains
installation program for the mesh generator. The users should consult the user’s
manual to learn how to use the mesh generator program. The mesh generator
program creates a file with a “.geo” extension that contains the gird information.
The format of the file with a “.geo” extension is described in detail in section 2.4.

2.3 Zooming and Panning

Once the mesh is displayed in the CCHE2D-GUI, the user can zoom and pan the
image by selecting the View—>Zoom and View—>Pan options respectively. The
same options can be selected by pressing the £ and ) icons in tool bar
respectively. As soon as the View—>Zoom or View—>Pan option is selected, a
check mark is placed beside that option in the pulled down menu and the button
on the tool bar changes to a hatched sunken pattern to show that the tool is
selected. To redraw the mesh to the original scale, select the View—>Fit to Full
Size option or press the [_] button in the tool bar. To zoom into an area, first select
the View—>Zoom option, next make a rectangular selection by pressing the right
mouse button at the starting point of the selection. Keeping the right mouse button
depressed, move the cursor to the end of the selection area and release the right
mouse button. As the cursor is moved with the right mouse button depressed, a
rectangular box is drawn and updated continuously to show the selected area. As
soon as the right mouse button is released, the last rectangular selection is zoomed
in. Once the Zoom option is selected, it remains selected till the user selects a pan
option. Thus the user can zoom continuously without having to re-select the
View=>zoom submenu.
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To pan the image (i.e., to translate the image to a new position), first select the
View->Pan option, next click at a reference point by pressing the rigth mouse
button. Keeping the right mouse button depressed, move the mouse to the position
that the user wants to translate the reference point to and release the right mouse
button. As the mouse is moved with its right button depressed, a line is drawn and
updated continuously from the starting point to the new position. Release the right
mouse button at the final position and the reference point will be translated to the
final point where the right mouse button was released. Thus the user can view
different part of the domain (by panning) while the image is zoomed in. As above,
the Pan option remains selected till the user selects zoom or pan option. The user
can pan legend or title by selecting Pan Legend or Pan Title option provided
under the View menu. As soon as any of the above pan option is selected, a check
mark is placed beside the selected option and the procedure outlined above can be
used to move the item around in the CAD window. The legend and title can only
be moved within the window, i.e., these items cannot be panned outside of the
window, whereas the image has no such restriction imposed on it.

In addition to the zoom capability described above, incremental zoom in ([#g]) and
zoom out () are also available as buttons in the tool bar. Each time one of the
above the button is pressed, the image will be zoomed in or zoomed out ten
percent around the center of the CAD window.

2.4 File Format

The file with a “.geo” extension contains information about the total number of I-
and J-nodes in the computational domain. For each node in the computational
domain, the file has the information regarding x- and y-coordinates, initial water
surface level, bed elevation, node identification number, and roughness value. The
first line in the file contains IMAX and JMAX values. The subsequent lines
contain six entries of x- and y-coordinates, initial water surface level, bed
elevation, node identification number, and roughness value for each node in the
mesh. Only the node identification number is an integer value (non-decimal point
number), all other values are real (number with decimal point). The interior nodes
have the node identification number of 0, -20000 is used for the nodes on the
boundary, and -10000 is used for the external nodes. External nodes are not used
during the computation process; these nodes are generated during structured mesh
generation process. The number of total lines in the file are IMAX * JMAX + 1.
The user can edit the file, e.g., by opening it in the Microsoft Excel, and should
save it again with the same name. The initial water surface elevation and
roughness value can be edited either through graphical means or manually by
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manipulating the file to better suit the application needs or to define different
value of roughness coefficient for different parts of the domain. A sample file
format is shown below.

Imax, Jmax
Doj=1, Jmax
Doi=1, Imax
x y wsl bed Isl r
Enddo
Enddo

2.5 Opening a New Geometry File with Current Settings

The user can open a new geometry file (if a geometry file is currently displayed)
with the current setting by selecting File—>Open File with Current Settings to
display the Grid Settings dialog box as shown in Fig. 2.4. The user can keep the
current view coodinates and the flood scale settings for the new geometry file.

Grid Settings . x|

[ Keep flood scale settings

™ Keep view coordinates

Fig. 2.4 Options for selecting the setting to keep

If the user keeps the view coordinates, the new file will be opened with the
current view coordinates. If the image is not visible, the minimum and maximum
coordinates of the new case are out of the view range. In that case, the user can
display the new image by selecting View=>Fit to Full Size option or the
corresponding tool in the tool bar. If the user chooses to keep the flood scale, the
current maximum and minimum values of the flood scale of all the variables will
be kept for the new grid file. To reset the flood scale, for the currently displayed
variable, to the actual maximum and minimum values, the user should select
Style> Reset Flood Scale.
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Open a Geometry File

Look in; Ia HotophiaCresk, j = =¥ Ef-
hu:utu:u.geu:u

File: mame: | Open I
Files of type: IGEDmetr_l,l Files [*.geq) | Cancel |
P

Fig. 2.5 Opening a geometry file

Once the user press the OK button, an Open a Geometry File dialog box, as
shown in Fig. 2.5, will pop up for geometry file selection. To cancel the action of
opening a new file, the user should press the Cancel button.
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2.6 Export the Displayed Image as a Bitmap

The user can export the currently displayed image in the CAD window in a device
independent bitmap (DIB) format by selecting the File—> Export Image As Bitmap
option. The selection of the option pops up an Export Image As BMP File window
as shown in Fig. 2.6. The user should type in the file name without an extension.
The image will be saved in the file with a “.BMP” extension to signify that it is a
bitmap image. The image will be saved as seen on the screen and can be displayed
in any application program that supports bitmap file format.

Export Image As BMP File ﬂﬂ
Cave i Ia Contraction j - I-:-_ai( -
File name: C ave I
Save as type: | DIB Files [*BMP) =] Cancel |
4

Fig. 2.6 Exporting image as bitmap file

2.7 Printing the Displayed Image

The user can print an image currently displayed in the CAD window to a desired
printer by selecting the File=> Print option or select the & button in the tool bar.
A Print window will pop up and the user can select the printer and press the Print
button to start printing. The user can preview the image and page layout before
printing by selectinge File=>Print Preview submenu. To change the layout
(portrait or landscape) and size of the page the user should select the File—> Print
Setup option and then choose appropriate options in the Print Setup window.
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Once the page layout and size is set, the user can print preview and then print the
image.

2.8 Saving and Opening Layout Files

To save the settings of the currently displayed image for later viewing, the user
should select Save Layout or Save Layout As from the File menu. A Save Layout
As LOF File dialog box as shown in Fig. 2.7 will appear prompting the user for
the filename. The file will be saved with a “.lof” extension. The layout file
contains the setting and not an image and the file cannot be opened in any other
application program for viewing.

cave Layout As LOF File 2] =|

Save it Ia Contraction j - I'j{ -

File name: Iﬁ Save I
Save as type: ILa_l,luut Files [=laf] j Cancel |
e

Fig. 2.7 A dialog box for saving layout

To view the saved layout, the user should select File=>Open Layout option to
reveal the Open a Layout File dialog box as shown in Fig. 2.8. Only the files with
with a “.lof” extension are shown and the user can double click or select the
layout file and then press the Open button to load the file. As soon as a layout file
is loaded, an Open a Geometry File Associated with the Layout File dialog box, as
shown in Fig. 2.9, pops up prompting the user to associate a geometry file with
the layout. After the selection of the geometry file, the layout will be displayed in
the CAD window. The user can associate a case that is different than the case for
which the layout was saved. Thus the user can view various cases with a layout
for comaprison purposes. This option also allows the user to reload the layout and
continue from the point where the user left off.
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Open a Layout File

Lok, ir: I'ﬁ Contraction j - I-:j( -

GridandBed.IDF

File name: || Open I
Filez of type: ILa_l,luut Files [=laf] j Cancel |
e

Fig. 2.8 A dialog box for opening layout

Open a Geometry File Associated with the Layout

Lok it: Ia Contraction j - £ B9~

Caonkraction,geo
Conkraction-Qrig.geo
mesh3l.geo
nilemesh, geo

File name: | Open I
Filez of type: IEEHEED Geomety Files [F.gen) j Cancel |
S

Fig. 2.9 Identify a geometry file for the layout



3 Mesh Editing

3.1 Introduction

The CCHE2D-GUI has three distinct states; the first state corresponds to mesh
display and the other two to the visualization of flow and sediment transport
results. When the user opens a geometry file (a file with a “.geo” extension), the
interface is in the grid-editing mode and Grid-> Show Grid File option is checked.
In this mode, the user can work with the Grid, AssignBC, and View menus. In
addition, the user can access some options under the Style menu and the Data
Probe option under the Data menu. The View, Style, and Data menus are common
to the grid editing, flow visualization, and sediment visualization mode. In the
grid-editing mode, the user can edit the mesh, i.e., add or remove I- or J-lines,
move nodes, move I- or J-lines. Also, in this mode, the user can assign initial
water surface level, change bed -elevation, provide initial bed material
composition for the sediment transport simulation, define sediment size classes,
assign roughness coefficient, define node strings to which boundary conditions
can be prescribed, and provide general, numerical, simulation, sediment transport,
and sediment parameters. The associated data probe can be wused to
examine/modify x- and y-coordinates, bed elevation, initial water surface level,
and roughness values at a node. If the interface is not in the grid-editing mode, the
options under the Grid and AssignBC menus will not be available to the user. To
make the options under above menus active, the user must select the Grid->Show
Grid File option first.

When the geometry file is opened, the interface displays bed elevation as colored
scaled contours in addition to the computational mesh and the Bed Elevation
option is selected in the drop down selection list provided in the tool bar. The user
has an option to display water surface level, roughness coefficient, or grid only by
selecting the Water Surface Level, Roughness Coefficient, or Grid Only option
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respectively from the drop down selection list. The water surface level is the
initial water surface level specified in the geometry file.

=4 Contraction - CCHE2D-GUI . - |EI|£|
File Grid AssignBC  Wiew Style Data  Flowvisualization  SedimentVisualization  Help
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Fig. 3.1 Displaying only the grid

Fig. 3.1 shows a gird in the CAD window with the Grid Only option selected in
the list box. The figure also shows all the display options available in the list box.
When the Grid Only option is selected, the boundary of the domain is shown in
blue while the interior grid is drawn in black.

3.2 Mesh Editing

The user can modify the generated mesh by adding I- or J-lines, deleting I- or J-
lines, moving I- or J-lines, or moving nodes. To edit a grid, the user should select
the Grid-> Edit Grid option or a crosshair tool (4-) from the tool bar. The Edit
Grid window will pop up and is shown in Fig. 3.2. In addition to the window’s
title, the title bar also shows the editing option currently selected. The cursor will
change from pointer to a crosshair to signify that the grid-editing tool is selected.
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To add I-lines, first click the Add I Line button in the Edit Grid window and then
click with left mouse button in the CAD window at a place where I-line needs to
be added. Fig. 3.3 shows an I-line added to the mesh along with the Edit Grid
window. Note that the window’s title includes the option selected. The bed
elevation, initial water surface level, and roughness values of the added nodes are
interpolated from the two neighboring nodes using inverse distance weighting. To
delete an I-line, the user should first select the Delete I Line button from the Edit
Grid window and then click on the I-line in the CAD window that needs to be
deleted. To move an I-line to a new position, first click the Move I Line button in
the Edit Grid window; next select the I-line to be moved; and lastly click at the
new position of the line. The line can be moved only within the cell on either side.
In case of moving a line, a line is added to the new location first and then line to
be moved is removed from the grid.

To move a node, first click the Move Node button and then follow the same
procedure as described for moving a line. The interface highlights the node to be
moved to facilitate the node editing. The user can move an internal node only
within the cells surrounding the node to be moved. The boundary node, however,
can be moved within the cells surrounding it or out of the original extent of the
domain. In case of an internal node, the bed elevation, initial water surface level,
and roughness values of the node at the new position are interpolated from the
original four nodes that bound the cell. In case of a boundary node, the original
values are kept, however, the user can edit the values using either the Data—> Data
Probe option or the Grid-> Assign/Modify Properties option.

The Undo button will undo the last action performed, while the Undo All button
will undo all the grid editing performed since last save. The Save button will save
all the editing performed. The Exit button will quit the tool and the Edit Grid
window will disappear. However, if there were changes made since the last save,
the user will be prompted whether to save those changes or disregard them.

3.3 Modifying Nodal Properties

When a mesh is generated, the water surface level and roughness values in the
geometry file are set to zero. The user must specify appropriate values for both
these quantities at all nodes in the domain. To assign initial water surface level,
roughness values, change the bed elevation, modify node type, or interpolate the
specified initial water surface along I- or J-lines; the user should select the
Grid-> Assign/Modify Properties option to display the Nodal Properties window
as shwon in Fig. 3.4. The Whole Domain and Sub-Region options are initially
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deactivated. As soon as the user selects the Initial water surface level, Roughness,
or Bed elevation option in the Nodal Properties window, the above two options
become available to the user.

Nodal Properties x|

—Agzign WSL, Roughness, or Bed Elevation—

™ Initial water surface level
™ Roughness

™ BEed elevation

w'hole Domain Sub-Feaion

™ Azzign new |0 to nodes
Select a region by clicking on bwo
different nodes.

" Interpolate initial water suface level
|dentify a region by zelecting bwo nodes.

sae_|
rndo All E st |

Fig. 3.4 Nodal Properties window

il

In addition to the window’s title, the title bar will also show the currently selected
option such as Assign WSL, Assign Roughness, Assign Bed Elevation, Change
Nodes ID, or Interpolate WSL. The user can assign a constant value of the initial
water surface level, roughness coefficient, or bed elevation to all the nodes in the
domain or assign it to a sub-region selected by the user. If the user selects Initial
water surface level, Roughness, Bed elevation, or Interpolate initial water surface
level option, the CAD window will show the grid along with color scaled contour
of the respective quantity. In case the user selects the option to change nodes
identification, only the grid will be shown in the CAD window. However, the user
can change what is being displayed any time by selecting an appropriate option
from the list box.

The Undo button eliminates the last modification made to the grid, while the
Undo All button eliminates all the changes made to the grid since the last save.
The Save button saves all the modification performed till that moment, and the
Exit button quits the tool. However, if there were changes made, the user will be
prompted whether to save those changes or disregard them.
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3.3.1 Specifying Initial Water Surface Level, Roughness, or Bed Elevation

To set a constant value of initial water surface level, roughness, or bed elevation
for the whole domain, the user should first select the appropriate option by
clicking in the radio button to the left of the option. As soon as the user selects an
option, the title bar is updated to show the option currently selected. In addition,
the CAD window is updated to show the image corresponding to the selected
option. Next, click the Whole Domain button to display the Assign Value dialog as
shown in Fig. 3.5. Key in the value and press the OK button to assign the value to
the whole domain. The CAD window will be updated to show the changes.

Modal Properties--Assign WSL |

—Azzign WL, Roughness, ar Bed Elevation—

%' |nitial water surface level

" Foughness Assign Yalue x|

" Bed elevation Specify initial water suface. Make zure the value iz higher

than bed elevatiorn.

YW hole Domain I Sub-Regon

i~ Azzign new |0 to nodes
Select a region by clicking on bwo Walue Id
different nodes.

™ Interpolate initial water suface level Caricel |

|dentify a reqion by zelecting twa nodes.

Unda | Save |
[Inda Al | E =it |

Fig. 3.5 Assigning a constant water level for the whole domain
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To assign initial water surface level, roughness, or bed elevation to a sub-region,
first select the appropriate option and then click the Sub-Region button. The user
can select a sub-region in the CAD window by clicking on two distinct nodes with
the left mouse button. The first click highlights the selected node by a filled circle.
As soon as the second node is clicked, both clicked nodes along with the nodes
that lie within and at the boundaries of the selected area will be highlighted by
filled circles. The user can select a single node by clicking on it twice. In case the
two nodes lie along an I- or J-line all the interior nodes and the two selected nodes
will be highlighted. As the user clicks the second node, the Assign Value window
will pop up prompting the user to input the value to be assigned to the selected
nodes. Fig. 3.6 shows the CAD window with nodes selected and the Assign Value
window for inputting the roughness value for the region selected. As soon as the
user inputs the value and presses the OK button, the CAD window is updated to
reflect the changes made to the nodes property.
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Fig. 3.6 Assigning properties to a sub-region
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3.3.2 Modifying Node Type

As discussed above, the CCHE2D model uses node identification number to
assess the position of a node in the computational domain. A value of 0 means
internal nodes, boundary nodes are identified by a value of —20000, and —10000 is
used for external nodes. External nodes are used in the process of generating
structured mesh and may be used to place instream hydraulic structures and
islands in the computational domain after the mesh has been generated.

The interface identifies an element as valid if it has at least one internal node. An
element with all boundary nodes or boundary and external nodes is excluded
during computation. The user must take a great care in changing the nodes
identification number as it may result in an ill defined mesh and the model would
fail to run. Once a node is changed to an external node, it cannot be selected. The
best strategy is to define the boundary nodes first and then change the interior
nodes to external.

set Node ID : x|

" Set as boundany

i Set as external

ok I Cancel

Fig. 3.7 Node type selection

Press the Assign new ID to nodes option in the Nodal Properties window to start
changing node type. The CAD window will display grid only and the boundary of
the computational domain will be shown in blue. The Whole Domain and Sub-
Region opitons will be deactivated. To change the type of a single node, the user
should double click that node and then select an appropriate option in the Set
Node ID window shown in Fig. 3.7. To change outer boundary of a selection to
boundary nodes, first select two distinct nodes. As soon as the second node is
selected, the nodes in the selected region will be highlighted and the Set Node ID
window will pop up prompting the user to select node type. Select the Set as
boundary option and press the OK button. A rectangle in blue color is drawn to
show that the nodes lying on the boundary of the selected domain are changed to
boundary nodes. One such example is shown in Fig. 3.8. In Fig. 3.9, the type of
the interior node is changed to external thus creating an island in the channel.
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Fig. 3.8 Changing internal nodes to boundary nodes
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Fig. 3.9 Changing interior nodes to external nodes
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To define a dike in the channel that is one cell wide, the user should click two
nodes and change the nodes on the outer boundary of the selection to boundary
nodes. Since there are no interior nodes, the outer boundary of the computational
domain will be adjusted to form a dike. Fig. 3.10 shows a dike added to the
computational domain. The dike is only a cell wide and the selected sub-region
does not have any interior nodes. To define a dike that is more than a cell wide,
the user must change the interior nodes of the selected sub-region and the nodes
that lie on the original computational domain boundary to external nodes.
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Fig. 3.10 Defining a dike that is a cell wide

If the user changes some nodes to external nodes without defining the outer nodes
as boundary nodes first, some of the elements may contain both internal and
external nodes. However, for an element to be valid, it must contain internal
nodes only or internal and boundary nodes. Elements that contain both internal
and external nodes are non-valid element. To warn the user and identify such
elements, the external nodes of such elements are highlighted by purple color.
Fig. 3.11 shows a grid where a group of nodes are selected and changed to
external nodes. The nodes that are highlighted in purple are part of elements that
have internal nodes. This will signal the user that a boundary must surround these
nodes or else the mesh will be ill defined.
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Fig. 3.11 Highlighted external nodes
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3.3.3 Initial Water Level Interpolation
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When providing the initial water surface level, the user must make sure that all
inlet and outlet sections must have positive depth. Only constant initial water
surface level can be provided for the whole domain or sub-region. In order to
avoid large water depth at the downstream end of the channel, the user must either
provide water surface level by sub-regions or interpolate the water surface level
provided at the inlet and outlet sections. If the two ends of a channel are
connected by constant I-lines than the interpolation must take place along
constant I-lines. The initial water surface level must be provided along all
constant J-lines boundaries within the domain that is selected for interpolation and
that are followed or preceded by J-lines with external nodes. That is, if there are
dikes or islands within the domain of interpolation, the user must provide water
surface level along the boundaries that run along constant J-lines and are followed
or preceded by J-lines with external nodes. Fig. 3.12 shows initial water surface
level prescribed at inlet (left boundary) and outlet (right boundary). The inlet and
outlet sections are connected by constant I-lines and the interpolation will be
performed along these lines.

D'ﬁn|§|‘?”WaterSurraceLevel j|—|—|$’?|ﬁ@|:||ﬁ
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Fig. 3.12 Initial water surface level defined at inlet and outlet
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Select Interpolate initial water surface level option from the Nodal Properties
window and then click two distinct points in the CAD window to select an
interpolation region. In this case, the user should select the upper left and lower
right nodes to select the whole domain. As soon as the second node is selected,
the nodes in the selected domain will be highlighted to show the interpolation
region and a window titled Initial Water Level Interpolation, as shown in Fig.
3.13, will pop up. The window prompts the user to select interpolation direction,
i.e., along constant I-lines or constant J-lines. After selecting an appropriate
option, the user should select the OK button to interpolate water level and update
the image in the CAD window.

Initial Water Level Interpulatuiif x|
¥ |nterpolate along constant |-ines

" |nterpolate along constant J-lines

Cancel |

Fig. 3.13 Interpolation direction

The user can interpolate initial water surface level within any sub-region or along
a selected I- or J-line. If interpolation is along constant I-lines, the interpolation
region should contain at least three nodes along I-lines.
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3.4 Monitor Points

Monitor points are used to get history of results at selected nodes. The current
version of the CCHE2D model allows up to five monitor points in the
computational domain. As the CCHE2D model is an unsteady flow model, even
the steady state is attained through forward marching in time. Thus monitor points
are valid both for the steady and unsteady flow simulation. In case of steady flow
simulation, the monitor points can be used to assess convergence of the run.
While in case of unsteady flow, these points can be used to observe the
flow/sediment transport pattern at selected points in the computational domain. If
monitor points are specified, the CCHE2D model outputs the results for each of
the point after “n” time steps (where n is the number of time steps specified by the
user). The monitor points information are saved in a file with a “.mon” extension.

To display and edit the existing monitor points or add monitor points, the user
should select the Grid—> Edit Monitor Points option to display the Edit Monitor
Points window as shown in Fig. 3.14. The CAD window displays only the grid
and the monitor points, if any, are shown in purple color except the currently
selected monitor point that is shown in black color. The user can change the
displayed image by selecting an appropriate option from the list box.

Edit Monitor Points x|

— Moritor Point Coordinates

— Manitar Paint [ndices

| index % coardinate [rm)

— C—
Jindex O R

y coordinate [m]

Add Paint | Add Paint |
Select Maonitor Point | Add Points from Grid | Save I

Remove Current F'u:uintl Remowve All Paintz | E st |

Fig. 3.14 Edit Monitor Points window
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The user can select a monitor point in three different ways: first to specify a
monitor point at a specific I- and J-indices, input the values in the appropriate
field under the Monitor Point Indices option and then press the Add Point button;
secondly to specify a monitor points at a particular location, key in the values for
x- and y-coordinates in the fields under the Monitor Point Coordinates option and
then select the Add Point button to select a node closest to the coordinates
provided as one of the monitor point; and lastly the user can select a node in the
CAD window by clicking on it with the left mouse button after pressing the Add
Points from Grid button in the Edit Monitor Points Window. As soon as the user
select the last option, the title of the window will also show Add Points From
Grid to illustrate the current mode.

To remove all the monitor points, press the Remove All Points button. To remove
the currently selected monitor point (the point that is shown in black color), press
the Remove Current Point button. To make any monitor point current, press the
Select a Monitor Point button and then click in the CAD window. The monitor
point nearest to the clicked position will become current (the color of the monitor
point will change to black). As soon as the user selects this option, the title of the
window will also show Select a Point to illustrate the current mode. Fig. 3.15
shows monitor points with current monitor point in black color.
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Fig. 3.15 Monitor points display
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3.5 Data Probe

The user can probe the data such as x- and y-coordinates, bed elevation, initial
water surface level, and roughness of a node by selecting the Data—> Data Probe
option or by pressing the data probe tool (¥) button from the tool bar to display
the Grid Probe window as shown in Fig. 3.16.
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Set
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Meut | I Frewvious | | Undo | Save |

Newd | Previousd | Undosll | Edt |

Fig. 3.16 Grid Probe window

As soon as the above option is selected, the cursor will change to a probe to
signify that data probe tool is on. In addition, the CAD window will highlight the
node selected by default. The node nearest to the center of the displayed image is
selected at the beginning and is shown in Fig. 3.17.
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Fig. 3.17 Grid with a node highlighted for data probing

The user can see the I- and J-indices and x- and y-coordinates of the highlighted
node in the Grid Probe window. In addition, the bed elevation, initial water
surface, and roughness values of the selected node are displayed in the fields
provided under the Modifiable properties of the node option. The user can modify
the x- and y-coordinates, bed elevation, initial water surface level, and/or
roughness of the selected node by specifying values in the appropriate boxes
given under the Modifiable properties of the node subset. Pressing the Set button
will replace the selected node data with the one specified by the user.

To save changes made to the grid, the user should click the Save button. The
Undo key eliminates the last change made to the grid and the Undo All button
eliminates all the changes that were made since last save. To select the next node
along I- or J-line or to select a previous node along I- or J-line, the user should
press the appropriate button provided in the Grid Probe window. The user can
select any node in the computational domain by just clicking on it with the left
mouse button in the CAD window. The user can also select a node by specifying
I- and J-indices of a node or x- and y-coordinates. In case the user specifies x- and
y-coordinates, the node closest to these coordinates will be highlighted.



Chapter 3: Mesh Editing 32

3.6 File Format

The monitor points information is stored in a file with a “.mon” extension. The
first line of the file contains one integer value that indicates the number of
monitor points specified (the current version of the CCHE2D model allows the
user to specify up to five monitor points). One line is required for each of the
monitor points with two integer values in each line. The first entry should be the
I- index and the second should be the J-index of the monitor point. The file format
is show below.

NMonPts
I, Ji
I, Jy

INMonPts J NMonPts



4 Setting Model Parameters

4.1 Introduction

After generating and editing the mesh, the next step is to specify general,
numerical, simulation, sediment transport, and sediment parameters. In addition,
the user must define sediment size classes if sediment transport option is turned
on. Sediment parameters include sediment specific gravity, transport option, and
sediment size classes. The numerical, simulation, and general parameters sets
physical properties of the water, selects turbulence and roughness option. It also
provides information to the model regarding the simulation time step, total
simulation time, time steps for saving monitor points output, and time steps to
save intermediate results.

The Set Parameters option under the Grid menu reveals the Set Parameters
window. The window contains general, numerical, simulation, sediment transport,
and sediment parameters dialog boxes. It also contains a dialog box for defining
the sediment size classes. These parameters must be set before starting the
simulation. Each dialog box is initialized with the default values. By default the
sediment transport simulation is turned off. If the user wants to specify sediment
boundary conditions, appropriate transport option must be selected in the
Sediment Transport dialog box. The following sections provide information on
how to set the general parameters, numerical parameters, simulation parameters,
sediment transport parameters, sediment parameters, and sediment size classes.



Chapter 4: Setting Model Parameters 34

To display the Set Parameters window, the user should select the Grid—>Set
Parameters option. The Set Parameters window is shown in Fig. 4.1. By default
the Numerical dialog box is displayed and the Apply button is deactivated. The
correspoonding title labeled as Numerical at the top of the window is in a raised
state to show the title of the currenlty displayed dialog box. The user can reveal
any dialog box by clicking on its title provided at the top of the window. As soon
as any change is made in the currently displayed dialog box, the Apply button will
become active. An active Apply button means that changes have been made in one
of the dialog box of the Set Parameters window. To save changes in a particular
dialog box, first reveal the dialog box by clicking on its title and then click the
Apply button. The user can press the Cancel button to ignore changes in the rest of
the dialog boxes and exit the Set Parameters window. Press the OK button to save
changes in all the dialog boxes of the Set Parameters window and exit the

window.
Set Parameters : El
Sediment Tranzpaort | Sediment | Sediment Size Clazses I
General Mumerical I Simulation
Sirnulation time [seconds) |1 0oo
Time ztep [seconds] IEI.E
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¥ hanning's n
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k. I Cancel Spply

Fig. 4.1 Set Parameters window




4.2 General Parameters

Set Parameters X|
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] I Cancel Apply

Fig. 4.2 General parameters dialog box

Selecting the General title in the Set Parameters window will display the general
parameters dialog box as shown in Fig. 4.2. The window has four parameters with
default values that suffice for most cases, however, if needed the user can change
the default values. The parameters are the Coriolis force coefficient, gravitational
acceleration, von Karman constant, and kinematic viscosity of fluid. The Apply
button is inactive, if the user makes any changes the button will become active.
Clicking on the active Apply button will save changes made in the General dialog
box only.
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4.3 Numerical Parameters

To specify the numerical parameters, the user must select the Numerical title in
the Set Parameters window to display the numerical parameters dialog box as
shown in Fig. 4.3. The user must specify six parameters or accept their default
values. In addition, the user must specify whether the roughness coefficient
specified is Manning’s n (default value) or roughness height Ks. After making
necessary changes, the user should press the Apply button to save the changes in

the dialog box.
Set Parameters X|
Sediment Transport | Sediment | Sediment Size Classes I
General Mumerical I Sirmulation
Simulation time [seconds] |1 ooa
Time step [seconds] ID-5
Wall ziphess coefficient I1
Turbulent wiscosity coefficient I1
Depth to conzider dy [m] ID-U4
[teration control flag (1, 2, or 3] I1
Bed Roughness Option
£+ Manning's n
" Fouhgness height Kz [m]

2k, I Cancel Spply

Fig. 4.3 Numerical parameters dialog box

The Simulation time (seconds) parameter specifies total time in seconds that the
simulaton would run. In case of steady flow, this time should be sufficient so that
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a steady state solution could be achieved. However, the user does not have to
specify very long time as the CCHE2D model can be re-run from the point where
it stopped the last time. The Time step (seconds) parameter is used to specify
computation time step ( Az ) in seconds.

The Wall slipness coefficient parameter is used to specify the wall boundary
condition at no-flow boundaries. A value of 0.0 means no slip condition and a
value of 1.0 means total slip, i.e., tangential velocity at no flow boundaries is
allowed. A value between 0.0 and 1.0 would mean partial slip. A value greater
than 1.0 signals the application of log-law. The log-law boundary condition
allows partial slip, however, the shear stress is accurately predicted.

The Turbulent viscosity coefficient parameter is a tubulence viscosity multiplier,
i.e., a value of 10.0 would mean that the turbulent viscosity is ten times that
computed from the selected turbulent closure scheme. A value of 1.0 for this
parameter suffice for most application.However, if the user has an application that
is difficult to simulate, the damping factor may be given an higher value initially
and then reduced to 1.0 in subsequent runs.The wetting and drying of a node is
determined on the basis of the Depth to conmsider dry (m) parameter. If the
computed depth is less than this depth, the node is considered dry.

The Iteration control flag (I, 2 or 3) parameter provides information about the
number of interations per time step. The values of 1, 2 , and 3 mean small,
medium, and large number of iterations per time step. The actual number is set by
the computational model. The value should be based on the time step size, i.e., if
the time step size is large the iteration control flag should be set to a higher value.
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4.4 Simulation Parameters

Select the Simulation title to display the simulation parameters dialog box as
shown in Fig. 4.4. There are a total of four parameters listed in the dialog box
with default values. The user can key in the desired value for the parameters or
accept the default values. In addition, the user must select the turbulence closure
model. Three turbulent closure schemes are available to the user and are listed
under Turbulence Model Option list box. The turbulent closure scheme based on
parabolic eddy viscosity model is selected by default. The mixing length model
and the k—¢ turbulent closure schemes are also available and may be more
suitable if the flow field contains re-circulation flow, or hydraulic structures are
present in the domain.

Set Parameters |
Sediment Tranzpaort I Sediment I Sediment Size Clazzez |
General I Mumerical Sirmulation

Time zteps to save intermediate file |5|:|

Time steps for convergence output |1 0

Tirne zteps far manitar paintz oukput IEI

Time steps for hiztory file output IEI

Turbulence Model Option
IF'araI:u:uIin: Eddy Wizcozity bModel j

IInsteady Flow Computation

[T Compute as quasi steady flow

Time Steps to reach steady state I1

k. I Cancel | Spply

Fig. 4.4 Simulation parameters dialog box
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If the flow boundary condition at any of the inlet section is unsteady, i.e.,
discharge hydrograph is specified, both the sediment and flow time steps are the
same and the flow and sediment transport simulations are performed for each time
step. However, for long-term simulation the computation time may be quite long.
To increase the computation efficiency, the user has the choice to turn on the
option that computes the unsteady flow as quasi-steady flow. In this case, the
discharge hydrograph provided by the user must be a step function. The discharge
during each step is considered as constant and the flow and sediment simulations
are performed as for steady flow. Suppose (Q;, T;) and (Qi+1, Ti+) represents two
consecutive hydrograph ordinates then for quasi-steady computation the discharge
Q; is assumed to be valid for the duration between T; and T;;. In case of unsteady
flow computation, the discharge is interpolated for any time between T; and Ti.;.
The Time steps to reach steady state edit box is activated if the Compute as quasi
steady flow option is turned on. The value specified by the user in the edit box is
used to reach the steady state during each step. Having made the necessary
changes the user should press the Apply button to save the values.

The Time steps to save intermediate file parameter is used to specify the number
of time steps after which the intermediate solution is written. This number should
not be too small as most of the simulation time will be spent in writing the
intermediate solution file. If a simulation is halted abnormally, this file can be
used to restart the simulation from the point the intermediate solution was written
the last time. The intermediate solution is saved in a file with an extension
“.mdw” and the final solution is written in a file with an extension “.str”. The
format of these two files is exactly the same. To restart the solution from the
intermediate file, copy the file with an extension “.mdw” to a file with an
extension “.str” and re-run the CCHE2D model.

During the execution, the CCHE2D model displays on the screen the maximum
relative difference of the velocity and water surface level occuring in the domain.
The Time step for covergence output parameter is used to specify the number of
time steps after which the model will display convergence of the velocity and
water surface level on the screen. If the user is running the model remotely on the
server provided by the center, this option is not valid.

The Time steps for monitor points output parameter is used to specify the number
of time steps afer which the model will write the simulation results for the
monitor points. The results for the monitor points are written to a file with a
“.mnt” extension. The history file is saved after every “n” time steps specified by
the Time steps for history file output parameter. The history file contains the
solution history and can be used for animation.
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4.5 Sediment Transport Parameters

Set Paramelters

General | Humerical I

Sediment Trarsport I Sediment I Sediment Size Classes

Tranzport Mode Selection

Simulation

I Mo Sediment Transport

Bed Roughness Calculation

IUSE the value in * gea file

[

-

— &daptation Length for Bedload

¥ Set as average gnd length
" Set as 7.3 of average dune length

" Specily adaptation length

—

—&daptation Factor for Suzpended Load
&' Bazed on Aminini and di Silvio [1338)

" Speciy adaptation factor

IEI.EIEIEI'I

] I Cancel |

Apply

Fig. 4.5 Sediment Transport parameters dialog box
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To specify the sediment transport parameters, the user should select the Sediment
Transport title provided at the top of the Set Parameters window. A dialog box as
shown in Fig. 4.5 is revealed to set the parameters related to sediment transport.
There are two drop down selection lists for choosing the transport mode and the
method for calculating bed roughness. The currently active options are shown in
the two list boxes. The user can specify the options for calculating adaptation
length for bedload and adaptation factor for suspended load or accept the default
selections as shown in the figure. These two options are related to non-
equilibrium sediment transport modeling. If the user selects the Specify
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adaptation length or Specify adaptation factor option, the corresponding input
field is activated and the user must specify an appropriate value.

Set Parameters El

aeneral | MHurnerical I Simnulation I
Sediment Transport I Sediment I Sedment Size Clazzes

Tranzport Mode Selection
Mo Sediment Transport j

Mo Sediment Tranzport

Bedload Transport

Suzpended Load Transport

Total Load az Bed Load Plus Suspended Load Model
Total Load a d Load Maodel
BN Total Load & zpended Load Model

Cohesive Sediment Model

{* Set as average gnd length

£ Set as 7.3 of average dune length

£~ Specify adaptation length ID

— &daptation Factaor for Suspended Load
¥ Bazed on Amminini and di Silvio (1988

™ Specify adaptation factar IEI.EIEIEH
k. I Cancel | Apply |

Fig. 4.6 Transport Mode Selection option

Fig. 4.6 shows the drop down menu related to the Transport Mode Selection
option. There are total of seven options. By default the sediment transport option
is turned off. If sediment transport simulation is required, the user should select an
appropriate transport option. Each of the second, third, and fourth option have
only one sediment transport equation associated with it and is selected
automatically by the interface. The fifth and sixth options have three sediment
transport equations each associated with it. As soon as the user selects one of
these two options the Select Transport Capacity Formula window, as shown in
Fig. 4.7, pops up prompting the user to select the transport formula. If a formula
was previously specified it will appear as the selected formula in the window.
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Select Transport Capacity For x|

£ whu et al, formula

™ Modified &ckers and ‘White formula
" Muodified Engelund and Hansen formula

" SEDTR& module

Cancel |

Fig. 4.7 Select Transport Capacity Formula

After selecting the appropriate formula, the user can press the OK button to
register the new transport mode. If the user presses the Cancel button, the
previously selected option for the transport mode will be displayed in the
Transport Mode Selection list.
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If the user selects the last option, i.e., the Cohesive Sediment Model option the
Cohesive Sediment Parameters window as shown in Fig. 4.8 is displayed. The
window contains seven parameters with default values; the user can accept the
default values by pressing the OK button or make necessary changes and then
press the OK button. The parameters will be registered and the Cohesive Sediment
Model option will be selected in the Transport Mode Selection list. If the user
presses the Cancel button, the previously selected transport mode will be become
the current option in the Transport Mode Selection list.

x|
Cp Concentration at max. zetting velocity [kgm] I'IE‘
m Exponent of zettling welolcity for C < Cp[1-2] |1 5
r Exponent of zettling welocity for C > Cp [3-5] |4
b Erozion coefficient [kadz/nf) IU.DUU'I
Tau_be Crtical bed shear stress for erosion [kgme] |1
Tau_d.max Critical shear for suspension ID-5
Tau_d.min Critical =hear for deposition ID
Cancel |

Fig. 4.8 Cohesive Sediment Parameters window

The first three parameters in the Cohesive Sediment Parameters window are
related to the settling velocity versus concentration curve. The settling velocity
initially increases with the increase in concentration of the cohesive sediment. The
settling velocity reaches a peak value at a concentration say Cp and then starts to
reduce with further increase in concentration. The next two parameters are
associated with the erosion of the cohesive sediment. The second last parameter
represents the shear stress above which all the sediment remain in suspension and
the last parameter represents the shear stress below which all the sediment is
deposited on the bed.
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Set Parameters X|
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Mo Sediment Transport j

Bed Roughness Calculation
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Fig. 4.9 Bed Roughness Calculation option

Fig. 4.9 shows the options available under the Bed Roughness Calculation option.
The options available in the drop down menu controls the way the bed roughness
is computed during simulation. If the first option Use the value in *.geo file is
selected, the CCHE2D model will use the roughness value specified in the
geometry file throughout the computation process. For other options, the model
computes the bed roughness after every time step based on the specified criteria.
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4.6 Sediment Parameters

To specify the sediment parameters, the user should select the Sediment title in the
Set Parameters window. A dialog box shown in Fig. 4.10 will appear. The
sediment specific gravity has a default value of 2.65 that suffices for most
applications. The curvature effects under the Bank Erosion Parameters option are
ignored by default. The user should click in the box beside the Include curvature
effects option to activate it. A check mark appears in the square box and the
Average channel width (m) edit box is activated to receive the user input.

Set Parameters X|
General I Mumerical I Simulation I
Sediment Tranzpaort Sediment | Sediment Size Clazzez

Sediment specific gravity IE-EE'I

— Bark Erozion Parameters

[T Include curvature effects

Ayerage channel width [m] 0

Steady Flow Computation

Sediment step size factor I'I

Time steps bo adjust low IEEI

Erozion/D epositian lirmit [0.01-0.05 of depth] ID-':I2

2k, I Cancel | Apply

Fig. 4.10 Sediment parameters dialog box
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The Sediment time step factor is used to obtain the simulation time step for
sediment transport computation. The flow time step specified in numerical
parameters is multiplied by this factor to obtain time step for sediment
computation. The Time steps to adjust flow parameter is used to adjust the flow
after the bed changes. The flow will be recalculated for the number of time steps
specified by the user. The Erosion/Deposition limit (0.01-0.05 of depth) is used to
restrict the maximum amount of erosion/deposition in the domain within a time
step. If erosion/deposition at any node within a time step exceeds the limit
specified by the user, the time step is reduced and computations are repeated. The
above parameters are effective only if steady flow boundary conditions are
prescribed at all the inlets.

If the Include curvature effects option is turned on, the Average channel width (m)
edit box will be activated. The user must provide average channel width. After
making the necessary changes, the user can press the Apply button to save the
changes made in the sediment parameters dialog box.
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4.7 Sediment Size Classes

The user must supply the sediment size classes that compose bed material and
incoming sediment at inlets. To input the size classes, the user must select the
Sediment Size Classes title in the Set Parameters window to display the size class
specification dialog box shown in Fig. 4.11.

Set Parameters El
General I MHurnerical | Simulation |
Sedirment Trarsport I Sediment Sediment Size Classes

kean diameter [m]
of each size class Diameter [m]

A 0

Add Size Class |

Delete Size Clazs |

Cleardl |

[

k. I Cancel Spply

Fig. 4.11 Sediment Size Classes dialog box

To add a size class, just input the mean diameter in meters for that particular size
class in the input field (located above the Add Size Class button) and press the
Add Size Class button. The diameter is added to the list. To add another size class,
the user should repeat the above process. The diameters in the list are
automatically sorted in ascending order. Only unique value can be added to the
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list. To delete a size class from the list, select the corresponding diameter in the
list by clicking on it and press the Delete Size Class button. To clear all the size
classes, press the Clear A/l button. Each diameter in the list represents a size class
and the number of size classes must be the same as will be or is specified in the
initial bed material composition file and in the sediment boundary condition files.
To save changes in the sediment size class specification dialog box the user
should press the Apply button.

4.8 File Format

The general, numerical, simulation, sediment transport and sediment parameters
are written to files with “.ph pmt”, “.nm pmt”, “.sm pmt”’, “.ns pmt, and
“.sd_pmt” extensions respectively. The file with a “.ph pmt” extension contains
one line with six entries (all real values). The first four entries are Coriolis force
coefficient, gravitational acceleration, von Karman constant, and fluid viscosity.
The last two entries are related to English system and are not used by the model.
These fields may contain dummy values.

The file with a “.nm_pmt” extension contains two lines. The first line contains
five parameters that have real values. These parameters are simulation time, time
step, wall slipness coefficient, turbulent viscosity coefficient, and depth to
consider dry. There are three parameters with integer values in the second line.
The first parameter is related to roughness option (1 for Manning’s n and O for
roughness height option). The second one is a dummy value and is set to zero.
The third value is related to iteration per time steps and has a value of 1, 2, or 3
and corresponds to small, medium, and large number of iteration respectively.
The actual number of iterations is determined by the model.

There are two lines with eleven parameters that have integer values in the file
with a “.sm_pmt” extension. In the first line, the first two values are dummy
parameters and should have values of 1 and 0 respectively. The entries three to
five are time steps to save intermediate file, time steps for convergence output,
and time steps for monitor points output. The first entry in the second line is time
steps for history file output. The second, third, and fifth entries are dummy
parameters and should have values of zero. The fourth entry corresponds to
turbulent model option. It should have a value of one for parabolic eddy viscosity
model, two for mixing length model, and five for k—¢ model. The sixth entry
corresponds to computing unsteady flow as quasi-steady flow. A value of zero
means that the option is turned off. A non-zero value signals that the unsteady
flow would be computed as quasi-steady flow and the number of time steps that
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will be used by the model to achieve steady state flow conditions during each step
of the hydrograph is given by this parameter.

The first line in the file with a “.ns pmt” extension contains one parameter
(integer value) that corresponds to the sediment transport mode selected by the
user. The value ranges from zero to six and corresponds to the options available
under the Transport Mode Selection list in the Sediment Transport dialog box
shown in Fig. 4.6. The second line contains one integer value that provides
information about the sediment transport formula to be used. The third line also
contains one integer value that provides information about the method to be used
for calculating bed roughness during sediment transport simulation. The value
ranges from one to five and is related to the option selected under the Bed
Roughness Calculation list in the Sediment Transport dialog box shown in Fig.
4.9. The fourth line contains one integer value that is related to steady or unsteady
sediment transport model and is evaluated based on the type of inflow boundary
conditions. The value is one if the inflow boundary condition is unsteady and zero
if the inflow boundary condition is steady.

The fifth line contains two values (both integers). These values are related to the
adaptation length for bedload and adaptation factor for suspended load
respectively. A value of one corresponds to the user specified values for both
adaptation length and adaptation factor. If the first value is one, the value of
adaptation length is expected in the next line. If the second value is one, the value
of adaptation factor as specified by the user should be provided in the next line. If
cohesive sediment is selected as a transport mode, the last line contains seven
parameters all real values and are related to the properties of cohesive sediment.
The seven values are in the order listed in the Cohesive Sediment Parameters
window shown in Fig. 4.8.

The file with a “.sd_pmt” extension contains three lines. The first line contains
four integer values. The first two values are always set to zero. The third value is
always set to one and the fourth parameter is always zero. The second line
contains six entries. All values except the fourth are real. The first value is the
specific gravity of the sediment, the second entry is a dummy value having a
value of zero, and the third entry is the time step factor for sediment simulation.
The fourth value is the number of time steps to recalculate the flow, the fifth entry
specifies the erosion/deposition limit during a time step, and the last entry is a
dummy value having a value of 1.0. The last line contains two entries. The first
value (integer) corresponds to the inclusion of curvature effects for bank erosion
simulation. The curvature effects option is on if the value is one and off if the
value is zero. The second entry (a real value) specifies the average channel width.



S Initial and Boundary Conditions

5.1 Introduction

Once the mesh generation process is complete and parameter for flow and
sediment are set, the user needs to specify proper initial and boundary conditions.
If sediment transport option is turned on, the user must specify initial composition
of the bed. The user can specify multiple inlet and outlet sections for the domain.
The user can prescribe specific discharge, total discharge, or discharge
hydrograph at the inlet sections. At outlet sections, the user can prescribe water
surface level, open boundary condition, rating curve, or stage hydrograph. In
addition, the user can prescribe steady or unsteady sediment boundary condition
at the inlets. The first step towards prescribing boundary conditions is to select a
string of nodes at which an inlet or outlet boundary condition can be prescribed.
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5.2 Node String Manipulation

& Contraction - CCHEZD-GUI
File @Grid | assignBC Wiew Style Data FlowVisualization SedimentVisualization Help

0 & |
Initia

The options under the AssignBC menu are available only if the interface is under
the grid-editing mode, i.e., the Grid->Show Grid File option is turned on. If the
option is not on, the user should select the Grid->Show Grid File option to turn it
on. The user can reveal the pull down menu as shown in Fig. 5.1 by selecting the
AssignBC option from the menu bar. If node strings are not present, the only
option availabe to the user will be Add Node String. If a node string exists, all four
options related to the node string (Add Node String, Select Node String, Delete
Node String, and Modify Node String) will be avialable to the user. The first set of
options in the 4ssignBC menu is related to the node string control and the second
set is related to associating an inlet or an oultet section with the node string. As
soon as the user selects a node string option, the CAD window will be updated to
show gid only. However, the user can change what is being displayed by selecting
an appropriate option from the drop down list box in the tool bar.

&dd Mode String

Select Node String
Delete Mode String
Modify Mode string

S+ |looO0MBEER|T|L 1o

Inlet Boundaty Condition
Gutlet Eoundary: Condition

-0.050  -0.025 0.000 0.025 0.050

IL, 3, %, v, var = 1, 1, 0,000000, 3.000000, 0.000000

Fig. 5.1 NodeStringControl menu
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5.2.1 Adding a Node String

To add a node string, the user should select the AssignBC>Add Node String
option. The option AssignBC->Add Node String is checked to show that the
option is currently active. The option remains active till the user selects another
option from the node string control set. To select a node string, two nodes must be
selected in the CAD window using the left mouse button to identify its beginning
and end. The selected nodes are highlighted and as soon as the user clicks the
second node, the node string is highligthed by connecting all its node with a
purple line and drawing a square in the middle. Two node strings, one at each end
of the channel are shown in Fig. 5.2. A node string must have at least three nodes,
be along an I- or a J-line of the mesh, and must include boundary nodes only (-
20000 nodes). If these conditions are not met, a dialog box will pop up with
appropriate error message. If the interface is restarted and a “.geo” file is opened,
the mesh will be displayed and node strings, if any, will be highlighted. A node
string with a square signifies that a boundary condition is not yet associated with
it.

& Contraction - CCHEZD-GUI . _'IEIILI
File @Grid AssignBC  Miew Style Data  FlowVisualization  SedimentVisualization  Help
D& E & ?||orcony 4|/ lo O ME|#EME|T|L I o)
.-‘-‘-_\_.‘_‘_--‘-.
'\-._____h
-l-_\_-_‘-
— ] _---"_‘-.
— [
[ —— ] [ —
-_h-_-ﬂh-'-—__
—d1 |
T
< AT
L T |
_-_-_--___-.-—-'-"--_-
_..--""'--__—"_—r-_ foe=
| — ___,_..-"'
| ] L
-—-""-
.-""-J
.--'--.-__--.
L —
Ready [, 3, % v=1, 5, 2000000, 2.600000 =

Fig. 5.2 Node string display
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5.2.2 Selecting a Node String
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Fig. 5.3 Selection of a node string

In order to apply an inlet or an outlet boundary condition, a node string must be
selected. To select a node string, the user should select the AssignBC->Select
Node String option first. This option is available only if a node string is present in
the computational domain. The option will be checked to show that the Select
Node String option is currently active. The option remains active till the user
selects another option in the node string control set. Next, move the cursor within
the square box of the node string to be selected and click with a left mouse button.
The square box will be highlighted by filling it with purple color, as shown in Fig.
5.3, to highlight the currently selected node string. As soon as a boundary
condition is associated with the node string, the square box will turn into a circle
(inlet section) or a circle with a cross inside it (outlet section). If a user selects a
nodes string that has a circle or circle with a cross, a dialog box will pop up
showing the associated boundary condition. The user can select another node
string by repeating the above process. Only one node string can be selected at a
time.



Chapter 5: Initial and Boundary Conditions 54

5.2.3 Deleting a Node String

To delete a node string, first select the AssignBC-> Delete Node String option. The
option is available only if a node string is present. A check mark is placed beside
the option to show that it is currently active. The option remains active till the
user selects another option from the node string control set. Next, move the cursor
with in the square box (circle in case of an inlet section or circle with a cross in
case of an outlet section) of the node string to be deleted and click in it with a left
mouse button. The node string is removed along with the associated boundary
condition, if any. To delete another node string, repeat the process described
above.

5.2.4 Modifying a Node String

To modify a node string, the user should select the AssignBC->Modify Node
String option first. The option is available only if a node string is present. A check
mark is placed beside the option to show that it is currently active. The option
remains active till the user selects another option from the node string control set.
To modify an existing node string, the user must click two points in the CAD
window. The first clicked point selects the closest start or end node of a node
string and is highlighted. The second click selects a node to which the highlighted
node is moved thus modifying the node string. The end node of a string can only
be moved along the line that contains the string. That is, if the original string is
along a certain constant I-line, the node selected by the second click is a node that
is closest to the clicked point and lies in that I-line.
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5.3 Specifying Inlet Boundary Conditions
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Fig. 5.4 Inlet Boundary Condition window

The AssignBC-> Inlet Boundary Condition option is available only if a node string
is selected. So the user should first select a node string as described above and
then select the AssignBC->Inlet Boundary Condition option to display the Inlet
Flow Boundary Conditions window as shown in Fig 5.4. The window contains
options for specifying both the flow and sediment inlet boundary conditions. The
Flow title at the top of the Inlet Boundary Conditions window is selected by
default and a dialog box for specifying the flow boundary condition is displayed.
To apply/view sediment boundary condition, the user should select the Sediment
title to reveal the dialog box shown in Fig. 5.5 for specifying/viewing the
sediment boundary condition.
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Fig. 5.5 Sediment boundary condition dialog box

If no boundary condition is specified at the selected node string, the Delete Flow
BC and Delete Sediment BC buttons in the flow and sediment dialog boxes
respectively are inactive. In addition, the Apply button is inactive meaning that
there are no changes to save. As soon as the user makes any changes in either
dialog box, the Apply button becomes active. To save changes made in a dialog
box only, display the dialog box by pressing the appropriate title at the top of the
Inlet Boundary Conditions window and then press the Apply button. To save
changes made in both dialog boxes and quit the window, press the OK button. The
user should click the Cancel button to quit the window without saving.
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5.3.1 Inlet Flow Boundary Condition

Press the Flow title provided at the top of the Inlet Boundary Conditions window
to display the flow dialog box as shown in Fig. 5.4. In the flow dialog box, the
user has options to specify specific discharg, total discharge, or a discharge
hydrograph at the section. As soon as the user selects the Specific discharge (m’/s)
or Total discharge (m’/s) option, the accompanying text field becomes active so
that the user can key in the value for the option selected. If the Discharge
hydrograph option is selected, an Open a Discharge Hydrograph File window, as
shown in Fig. 5.6, pops up and prompts the user to select a file that contains
disharge hydrograph information and has an extension of “.dhg”. As the user
selects a file, the file name along with its path is displayed in the associated edit
box.

Open a Discharge Hydrograph File 2| x|
Laoak: in: I 3 Contraction j = I-:-_ai( -
Test1.dhg

File: mame: | Open I
Files of type: IDischarge Hydragraph Files [*.dha) j Cancel |
P

Fig. 5.6 Opening discharge hydrograph file

The first line of the file containing the discharge hydrograph information should
contain an integer value specifying the number of ordinates in the hydrograph
(i.e., number of lines in the file describing the discharge hydrograph). The
subsequent lines should contain two real values. The first value should be the total
discharge in cubic meters per second and the second value should be the
corresponding time in seconds. The disharge hydrograph data must be save in a
file with a “.dhg” extension.
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The user must specify the inflow angle in degrees. A default value of zero (flow
normal to inlet section) is provided in the text field. The flow angle is measured
with respect to the normal to the inflow section (positive counter-clockwise and
negative clockwise). Fig. 5.7 shows the flow dialog box with the total discharge
boundary conditions applied. The Apply button is active indicating that changes
are made by the user in the dialog box. The Delete Flow BC button is still inactive
as the flow boundary condition is not saved yet. The user should press the Apply
button to save the changes made to the flow boundary condition. As soon as the
user presses the Apply button, the flow boundary condition is saved, the Delete
Flow BC button becomes active and the Apply button becomes inactive (if there
are no changes made in the sediment dialog box). The user can press the OK
button to save the information in both the flow and sediment dialog boxes and
quit the window. If the user presses the OK button, the image in the CAD window
is updated and the square of the selected node string is replaced by a circle
signifying that it is an inlet section now.

Inlet Boundary Conditions ' 5[

Flou | Sediment I

— Boundary Flaw Optiohs

™ Specilic dizcharge [méds] I':I

£+ Total dizcharge [meds] |3.|:|

" Dizcharge hydrograph I

Inflow angle [deareesz) IEI

Delete FlawBC |

QF. | Cancel | Apply

Fig. 5.7 Application of flow boundary condition
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Fig. 5.8 shows a node string with a square at the right end of the domain
signifying that no boundary condition is associated with it. While at the left end of
the domian a circle in the middle of the node string signifies that it is an inlet
section.
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Fig. 5.8 Specification of an inlet boundary to a node string

To delete the inlet flow boundary condition, the user should press the Delete Flow
BC button provided in the flow dialolg box in the Inlet Boundary Conditions
window; a window will pop up prompting the user to confirm the action. If the
user confirms the delete action, all the option will be deselected and the Apply
button, if inactive, will beocme active to show that changes need to be saved.
Press the Apply button to save changes, i.e., remove the flow boundary condition.
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5.3.2 Inlet Sediment Boundary Condition

The user should select the Sediment title at the top of the Inlet Boundary
Conditions window to display the sediment dialog box as shown in Fig. 5.9. The
option available will depend on the sediment transport mode selected in the
Sediment Parameters dialog box shown in Fig. 4.6. By defualt sediment transport
computation will not be performed. So the user must first select transport mode in
the Sediment Parameters dialog box in order to be able to sepecify sediment
boundary conditions.

Inlet Boundary Conditions X|

Flow  Sediment

—Bedlnad Sediment

— Suspended Sediment

| OpenBCFie | Open BC Fie

[Nelete Sediment EC |

QF. | Cancel | Spply

Fig. 5.9 Sediment boundary condition dialog box

In Fig. 5.9 only the Bedload Sediment option is active and corresponds to the
transport mode selected in the Sediment Transport dialog box. As the user clicks
the Open BC File button, an Open a Bedload Sediment File dialog box as shown
in Fig. 5.10 will pop up prompting the user to select a bedload sediment boundary
condition file that has an extension of “.bbc”. The file name along its path will be
displayed in the associated edit box. The Apply button, if inactive, will become
active to reflect that user needs to save changes. As soon as the Apply button is
pressed, the sediment boundary condition is saved, the Delete Sediment BC button
becomes active and the Apply button is deactivated (if there are no changes made
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in the flow dialog box). To save the information in both dialog boxes and quit the
window, the user should press the OK button. The image in the CAD window is
updated and the square of the selected node string is replaced by a circle
signifying that it is an inlet section now.

Open a Bedload Sediment File ilil
Lok, ir: I'ﬁ Contraction j - I-:j( -
Test1.bbc

File name: | Open I
Filzz of type: IEedIDad Sediment Files [*.bbc] j Cancel |,-"'
A

Fig. 5.10 Opening sediment boundary condition file

To delete the inlet sediment boundary condition, the user should press the Delete
Sediment BC button provided in the sediment dialog box in the Inlet Boundary
Conditions window; a window will pop up prompting the user to confirm the
action. If the user confirms the delete action, all the option will be deselected and
the Apply button, if inactive, will beocme active to show that changes need to be
saved. Press the Apply button to save changes, i.c., remove the flow boundary
condition.

If at a selected node string the user either specifies flow boundary condition or a
sediment boundary condition, the node string is changed to an inlet section. The
square in the middle of the node string changes to a circle signifying that an inlet
boundary condition is associated with the node string. To view both the flow and
sediment boundary condition, just select the node string with a circle and the Inlet
Boundary Conditions window will pop up. To remove the inlet boundary
condition at a node string, the user should delete both the flow and sediment
boundary condition in their respective dialog boxes and then press the OK button
to save the changes. The circle in the middle of the node string will change to a
square signifying that the node string does not have any associated boundary
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condition. To delete both the boundary contions and the node string, the user
should follow the steps outlined for deleting a node string.

The user must provide a file for the bedload and/or suspended sediment boundary
condition. The bedload and suspended sediment boundary conditon must be saved
respectively in files with “.bbc” and “.sbc” extensions. The file format for both
type of boundary condition is the same. The first line of the file should contain
two integer values: the first one specifying the number of size classes; and the
second one the number of ordinates in the sediment discharge hydrograph. For
steady sediment boundary condition, the second value should be one. For each
sediment discharge hydrograph ordinate two line must be specified, the first line
should contain two entries both real. The first value is the sediment discharge in
kg/s and the second value is the time in seconds. For steady boundary condition
the time is ignored by the model. The second line contains the information about
the fractional distribution of size classes. The number of entries in this line should
be equal to the number of size classes specified. The first fraction should be for
the lowest size class and the last fraction should be for the largest size class. The
sum of all the fractional values should be equal to one. The total number of lines
in the file must be equal to 2 * N + 1, where N is the number of ordinates in the
sediment hydrograph. For the suspended sediment boundary condtion, the file
format is as described above. The sediment discharge in this case has a unit of
kg/m’. A sample file format is shown below.

SizeGroup Ordinates

Q T
f1 fz ........ fs izeGroup
QZ T2
fi £ ... fSizeGroup

QOrdinates TOrdinates
f1 f2 ........ fSizeGroup
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5.4 Outflow Boundary Conditions

The AssignBC->Outlet Boundary Condition option to specify the outflow
boundary conditions to a node string is available only if a node string is selected.
After selecting a node string as described above, the user should select the
AssignBC->Qutlet Boundary Condition option to display the OQutlet Flow
Boundary Condition window as shown in Fig. 5.11. The Delete BC button is
inactive signifying that the outlet boundary condition has not yet been specified at
the selected node string.

Outlet Flow Boundary Condition X|

— Flow Oplions

" Open boundamy condition

© wiater surface level [m) IEI

™ Rating curee I

™ Stage hydrograph I

Dutflow angle [degrees) IEI

[elete BC | Cancel

Fig. 5.11 Outlet Flow Boundary Condition window

The user has the option to prescribe open boundary condition, specify a water
surface level, specify a rating curve, or specify stage hydrograph. In case of open
boundary condition, the model will estimate the water surface level at the outlet
boundary based on kinematic wave condition. This option is valuable if a user
cannot assess water level at the channel outlet. To prescribe water surface level at
the outlet, the user must select the Water surface level (m) option. The associated
edit box will be activated and the user can key in the appropriate value.
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Open a Rating Curve File ilil
Loak in: Ia Contraction j - £% E5-
Teskl.row

File narne: || Open I
Fil=z of type: IFIating Curve Files [*.rov) j Cancel |
4

Fig. 5.12 Opening rating curve file

Open a Stage Hydrograph File 2] %]
Lok in: Iﬁ Contraction j - £ R~
Testl.shg

File name: || Dpen I
Files of type: | Stage Hydrograph Files [*.shg) i Cancel |
v

Fig. 5.13 Opening stage hydrograph file

To associate a stage-discharge relationship or stage hydrograph with the outlet
section, the user must select the Rating curve or Stage hydrograph option. A
Open a Rating Curve File dialog box, as shown in Fig. 5.12, or Open a Stage
Hydrograph File, as shown in Fig. 5.13, will pop up asking the user to select the
file containing the data. The rating curve and stage hydrograph information must
be saved in files with “.rcv” and “.shg” extensions respectively. The format of the
file containing stage-discharge relatonship or stage-time data is described next.
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The first line in the file should contain the number of ordinates (integer value) and
the susequent lines should containing two real values, stage and corresponding
discharge in case of stage-discharge relationship or stage and corresponding time
in case of stage hydrograph.

The user must specify the outflow angle in degrees. A default value of zero (flow
normal to outlet section) is provided in the text field. The flow angle is measured
with respect to the normal to the outflow section (positive counter-clockwise and
negative clockwise). Press the OK button to register the boundary condition or
press Cancel to ignore the input. As soon as the user presses the OK button, the
image in the CAD window is updated and the square of the selected node string is
replaced by a circle with a cross signifying that it is an outlet section.
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Fig. 5.14 Specification of an outlet boundary to a node string

Fig. 5.14 shows a node string at the right end of the doamin having a circle with a
cross to signify that it is an outlet boundary. To view or modify the outlet
boundary condition, the user should select the node string at the right of the
domain. The Outlet Flow Boundary Condition window will pop up and the user
can view or modify the outlet boundary condition for that section. To delete the
boundary condition, the user should select Delete BC button provide int the Qutlet
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Flow Boundary Condition window. A dialog box will pop up prompting the user
to confirm the action. If the user presses the OK button in the dialog box, the
outlet flow boundary condition will be deleted and the Outlet Flow Boundary
Condition window will disappear. Also, the image in the CAD window will be
updated, i.e., the selected noded string that had a circle with a cross at the center
will show a square now signifying that no bundary condition is associated with
that string. To delete both the boundary contions and the node string, the user
should follow the steps outlined for deleting a node string.

5.5 File Format

The boundary condition information is stored in files with “.bnd”, “.hyd” (for
inflow), “.rat” (for outflow), “.bdl” (for bedload at the inlet), and “.ssl” (for
suspended sediment at the inlet) extensions. In the case of channel contraction, the
information will be stored in files Contraction.bnd, Contraction.hyd,
Contration.rat, Contraction.bdl, and Contracton.ssl. The first line in the file with a
“bnd” extension should contain two entries having integer values. The first entry
should be total number of inlets and the second entry should be total number of
outlets in the computational domain. All the inlets sections are specified next and
are followed by all the outlet sections. Each inlet and outlet section is specified
using two lines. The first line should contain one entry of “INLET” if it is an inlet
section or “OUTLET” if it is an outlet section. The second line should contain
four integer values, I- and J-indices of first node and I- and J-indices of the last
node in an inlet or outlet section. The last line in the file should contain a single
integer having zero value.

The first line of the file with a “.hyd” extension should contain one entry only
having an integer value and should be the maximum number of ordinates in the
discharge hydrographs specified as a boundary condition at inlets. If the inlets do
not contain any discharge hydrograph, this value should be one. The boundary
conditions of all the inlets are specified next. The inlets should be in the same
order as specified in the file with a “.bnd” extension. The first line for each of the
inlet section should contain “INLET” only. The second line for each inlet should
contain one integer value specifying the number of the inlet. The third line should
contain two entries one integer and one real value. The first value is zero if
specific discharge is specified at the inlet; one if total discharge is specified; and
equal to the number of discharge hydrograph ordinates for that inlet if discharge
hydrograph is specified at the inlet. The second value is the inlet flow angle.



Chapter 5: Initial and Boundary Conditions 67

In case the specific discharge is specified at an inlet, the subsequent lines should
be equal to the number of nodes in the inlet. Each line should contain one entry
(real value) of specific discharge starting at first node in the node string and
ending at the last node. In case the total discharge is specified at an inlet, there
should be only one subsequent line (after the first three lines) with two entries
both real values. The first entry should be of discharge and the second is “0.0”. In
case the discharge hydrograph is specified at an inlet, the subsequent lines (lines
after the first three lines) should be equal to the number of ordinates in the
hydrograph as specified in the second line. Each line should contain two real
values. The first entry is the discharge and the second is time.

The first line of the file with a “.rat” extension should contain one entry only
having an integer value and should be the maximum number of ordinates in the
stage-discharge curves or stage hydrographs specified as a boundary condition at
the outlets. If the outlets do not contain any rating curve or stage hydrograph, this
value should be one. The boundary conditions of all the outlets are specified next.
The outlets should be in the same order as specified in the file with extension
“bnd”. The first line of the boundary conditions specification for each outlet
should contain “OUTLET” only. The second line should contain three values
(first two integer and the last real) that specify the outlet number, the number of
lines to flow, and the outlet flow angle. The second entry is zero if open boundary
condition is specified; it is one if a constant water surface level is specified; it is
equal to the number of ordinates in the rating curve; and in case the stage
hydrograph is specified the second value is negative of ordinates in stage
hydrograph.

If the user specifies open boundary condition, the input described above suffices.
If constant water surface level is prescribed at the outlet section, the user must
specify the value (real number) in the next line. In case stage-discharge
relationship or stage hydrograph is specified, the subsequent lines (equal to the
number of ordinates in the rating curve or stage hydrograph) should contain two
entries (both real). In case of the stage-discharge curve, the first value is for water
surface level and the second is for the discharge and in case of the stage
hydrograph, the first value is for water surface level and the second is for time in
seconds.



Chapter 5: Initial and Boundary Conditions 68

The format of the file with extension “.bdl” is described below. This file is used to
specify bedload transport boundary condition.

SizeClasses MaxHydrographOrdinates
d,
d

dSizeClasses

InletNumber HydrographOrdinates

Qsl T1
f] fz f3 ------- fSizeClasses
Qsl T1
f] fz f3 ------- fSizeClasses

QsHydrographOrdinates THydrographOrdinates

fl f2 f3 ------- fSizeClasses

The first line should contain two integer values specifying the number of size
classes and maximum number of the sediment discharge hydrograph ordinates
specified at the inlets. The subsequent lines should contain one real entry
specifying the mean diameter of each of the size class. The number of these lines
should be equal to the number of size classes specified. The bedload sediment
boundary conditions for all the inlets are specified next. The inlets should be in
the same order as specified in a file with a “.bnd” extension. The first line of the
boundary conditions specification for each inlet should contain two integer
entries. The first value is the inlet number and the second value is the number of
ordinates in the hydrograph. There should be two lines for each ordinate of the
discharge hydrograph. The first line contains two entries (both real) quantifying
the bedload discharge (kg/s) and the corresponding time in seconds. The second
line should contain fraction distribution of size classes. The first fraction should
correspond to the smallest size class and the last fraction to the largest size class.
The number of entries (all real) should be equal to the number of size classes. The
sum of fractions should be one.

The file with extension “.ssl” is used to specify the suspended sediment boundary
conditions. The file format is as described above. The units for the sediment
discharge should be kg/m’.
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5.6 Initial Bed Composition

If sediment transport option is turned on, the user must provide initial bed
material properties. A file that contains the information regarding number of size
classes, number of samples, mixing layer thickness, and sample definition should
be provided. The file must have a same name as the casename and should have a
“.bmt” extension. The format of the file is described below.

SizeClasses NumberLayers
MinThicknessMixingLayer

NumberSamples

1 POTOSity f1 f2 f3 ------- fSizeClasses

2 POI'OSity f] fz f3 ------- fSizeClasses
NumberSamples Porosity f; f, f5 ....... fSizeClasses

The first line contains two integer entries: the first one is the number of size
classes; and the second is the number of layers of the bed material. The second
line contains one real value that specifies the minimum thickness of the mixing
layer. The third line contains the total number of bed material samples. The
subsequent lines contain information about each sample. In each line, the first
entry is the sample number (integer value), the second entry is the porosity (real
value) of the sample, and the subsequent values (all real), equal to the number of
size classes, provide fractional distribution of size classes. The sum of the
fractions should be equal to one. The fractions correspond to size classes in
ascending order, i.e., the fraction for the smallest size class is provided first and
that of the largest size class the last.
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After the file casename.bmt is created, the next step in specifying the initial bed
material properties is to create a new bed material file. The file can be created by
selecting Grid-> Create New Bed Material File option. This would geneate a file
that has a “.bed” extension. If the bed material file already exists, selection of this
option would prompt the user for reinitialization the file that contains sedimetn
initial conditions. The user must specify the initial condition information after
reinitialization. If changes are made in the file with extension “.bmt” and those
changes need to be implemented, the user must reinitialze the sediment initial
conditions file. To provide or modify the bed material properties, the user should
select Grid-> Modify Bed Material Properties option to reveal the Modify Bed
Material Properties window as shown in Fig. 5.15. The Apply/modify erodobility
and erosion and deposition thickness option is selected by default. The Layer
Number Selection list box is inactive by default as it relates to layer selection. The
image in the CAD window is updated and displays erodibiltiy option of the nodes
by default. In addition, the selection list box is updated to show the quantities that
are available for display and modification. Fig. 5.16 shows the the quantities
available for display in the selection list box. The display options available to the
user in the selection list box are node Eroddibility, Maximum Erosion Thickness,
and Maximum Depostion Thickness.

The user can modify the value of the currently displayed quantity either for the
whole domain or for a sub-region. If the user selects the Whole Domain button, an
Assign Value window will pop up prompting the user to key in appropriate value
for the qunatity to be applied to the whole domain. To modify the value of a
single node or a sub-region, the user should first select the Sub-Region button and
then click twice in the CAD window. The user can select a sub-region in the CAD
window by clicking on two distinct nodes with the left mouse button. The first
click highlights the selected node by a filled circle. As soon as the second node is
clicked, both clicked nodes along with the nodes that lie within and at the
boundaries of the selected area will be highlighted by filled circles. The user can
select a single node by clicking on it twice. In case the two nodes lie along an I-
or J-line all the interior nodes and the two selected nodes will be highlighted. As
soon as the user clicks the second node, the Assign Value window will pop up
prompting the user to input the value to be assigned to the selected nodes.
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Modify Bed Material Properties
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Fig. 5.15 Modify Bed Material Properties window
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Fig. 5.16 Viewing erodibility or maximum erosion or deposition thickness



Chapter 5: Initial and Boundary Conditions 72

By default all the nodes in the computational domain are treated as erodible and
hence have a value of 1. To modify the erodibility of nodes within the domain,
first select the quantity titled as Erodibility from the selection list box and then
select a sub-region or whole domain option as described above. Key in the value
of 1 or 0 in the Assign Value window to make the node erodible or non-erodible
respectively.Similary, the user can change the values of maximum erosion and
deposition thickness for each node in the domain. The default value for the
maximum erosion and deposition limit is —90.0 m and 90.0 m respectively.

The user must specify layer thickness and sample number for each node and for
all the layers. The first step is to select the Assign/modify layer properties option.
As soon as the user selects the option, the Layer Number Selection list box in the
Material Properties window becomes active and the first layer is selected by
default .The Material Properties window with an active Layer Number Selection
list box is shown in Fig. 5.17. The image in the CAD window is updated to show
layer thickness for the first layer. The selection list box in the CAD window, as
shown in Fig. 5.18, now shows Layer Thickness and Sample Number as possible
display quantities. As discussed above, the user can modify the value for the
currently displayed quantity either for the whole domain or for a sub-region. To
display the currently selected variable for another layer, just select the desired
layer number from the Layer Number Selection list box provided in the Material
Properties window. Thus the user can visualize/modify layer thickness and
sample number for all layers specified by the user.
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The information about nodes erodibility, maximum erosion thickness, maximum
deposition thickness, layer thickness, and sample number is stored in a bed
material file with a “.bed” extension. The format of the file is described below.

SizeClasses NumberLayers
MinThicknessMixingLayer

NumberSamples

1 POTOSity f1 fz f3 ------- fSizeClasses

2 POI'OSity f] fz f3 ....... fSizeClasses
NumberSamples Porosity f; f, f5 ....... fSizeClasses
Do J =1, Jmax

Dol=1, Imax

If(NodeID .NE. —10000) Then

J 1 FlagErodible MaxErodibleThickness MaxDepositionThickness
1 Thickness SampleNo

2 Thickness SampleNo

NumberLayers Thickness SampleNo
EndIf

EndDo

EndDo

The first part of the file is copied from the file with a “.bmt” extension as
specified by the user. The subsequent entries in the file correspond to data for
each node that is not an external node (node identity is not — 10000). The order of
the node is same as given in the geometry file. For each node, a total of N+1 lines
of data are written, N being the number of layers specified by the user. The first
line has five entries: the first two (integer values) represent the J- and I- indices of
the node; the third entry (integer) is a flag that is zero if the node is non-erodible
and one if the node is erodible; the next two entries (real values) are maximum
thickness of erosion and deposition. The subsequent lines, equal to the number of
layers specified (in the ascending order of the layer), have three entries. The first
value (integer) is the layer number, the second value (real) is the thickness of the
layer, and the third value is the sample number (integer).



6 Simulation

6.1 Introduction

After generating the mesh, specifying the necessary parameters, and prescribing
the initial boundary conditions, the next step is to save the information in the
format required by the CCHE2D model and to perform the desired simulation.
The user can run the CCHE2D model locally on the machine or remotely on the
NCCHE server. In both cases, the user can run the model using the graphical user
interface.

6.2 Saving the Project Input Data

After having specified all the necessary input for the CCHE2D flow and sediment
transport simulation, the user must save the data in the format required by the
CCHE2D model before the simulation can be started. To accomplish this, the user
must select the File>Save CCHE2D Files option. The Save CCHE2D Files
option is available only when the interface is in the grid-editing mode. In addition,
the Save CCHE2D Files option is active only if the files need to be saved in the
format required by the CCHE2D model. That is, if the files are already saved in
the format required by the CCHE2D model, the Save CCHEZ2D Files option will
be inactive. The input data will be checked for consistency and any errors found
will be reported to the user. If there are no errors, the input data is stored in the
files and in format required by the CCHE2D model. The Save CCHE2D Files
option will become inactive. If the user makes any change in the boundary or
initial condition, the Save CCHE2D Files option will become active signaling to
user that the files need to be saved in the format required by the model.
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6.3 Execution of the CCHE2D Model Installed on Client Side
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If the CCHE2D model is available on the client’s PC along with the interface, the
user can run the CCHE2D model by selecting Run CCHE2D Model Locally
option provided under the File menu. The option will be available only if the
CCHE2D model is provided with the interface and the files are saved in the
format required by the CCHE2D model. Fig. 6.1 shows the Run CCHE2D Model
Locally option. The option is inactive as no case is loaded into the graphical user
interface.
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Fig. 6.1 Option for running the CCHE2D model locally
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Fig. 6.2 Active option for running the CCHE2D model locally
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Fig. 6.3 Simulaiton Options dialog box

In Fig. 6.2, the Run CCHE2D Model Locally option is active as the CCHE2D
model is present in the local machine and the files are saved in the format
required by the CCHE2D model. To start the simulation, the user should press the
Run CCHE2D Model Locally option. As soon as the user presses the option, a
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Simulation Options dialog box, as shown in Fig. 6.3, will pop up prompting the
user to select simulation option. The user should select appropriate simulation
option and press the OK button. A console, as shown in Fig. 6.4, will pop up and
the model will start running the case that is currently displayed in the CCHE2D-
GUIL. The console displays the percentage of the completed simulation.

Fig. 6.4 Console window showing the simulation process

The simulation process is independent of the GUI. Thus, the user can close the
interface or load another case without interrupting the model execution. If
intermediate file is written, the user can view the updated intermediate results by
selecting the FlowVisualization—> Intermediate Results File option.

The CCHE2D model simulation produces two flow results files, one with a “.str”
extension and the other with a “.mdw” extension. The first file is a final flow
solution file and the second is an intermediate flow solution file that is written
after certain number of time steps specified by the user as described above. If the
user chooses the second option in the Simulation Options window, a file with a
“.str” extension must be present, i.e., a flow solution file must exist. The third
option in the Simulation Options window is related to sediment transport
simulation. Before choosing this option, the user must make sure that a final flow
solution exists and the sediment transport option is turned on. The option can be
used to start a new sediment simulation. However, if a sediment solution (file
with a “.mds” extension) exists, it will be used to continue the sediment run.
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6.4 Execution of the CCHE2D Model on the NCCHE Server
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The clients of the CCHE2D model can run the model on a remote server. A server
is reserved by the National Center of Computational Hydroscience and
Engineering, The University of Mississippi, for the potential user of the model.
Users must have an authorized login name and password in order to be able to run

the CCHE2D model remotely on the server provided.

To run the model remotely, the user must be able to upload files to the server,
start the simulation, download the final and intermediate results files, check the
status of the run, stop the run, and remove the files from the server. The above-
mentioned capabilities are provided under Transfer Utility submenu in the File
menu as shown in Fig. 6.5.
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Fig. 6.5 Options related to transfer utility



Chapter 6: Simulation 80

£ Contraction - CCHE2D-GUI D =] 3
File Edit Grid AssignBC  View Style Data  FlowVisualization  SedimentVisualization  Help
ew coe /oo IMEBE T LI

All the options under the File> Transfer Utility are inactive as no case is open. In
addition, the upload, download, and check progress buttons shown on the tool bar
respectively as |, |, and 3 are also inactive. If a file is loaded, the Transfer
Utility-> Setup Connection option will be available to the user and is shown in
Fig. 6.6. Once the connection to the server is established, most of the options
under Tranfer Utility submenu will become active. The Upload Files option under
the Transfer Utility submenu or the corresponding button on the tool bar will
become active only if the Save CCHEZ2D Files option is inactive, i.e., the files are
saved in the appropriate format. An inactive Upload Files option means the user
has not not yet saved the files in the appropriate format, or the user has made
changes since the last time the files were saved in the appropriate format. As
mentioned above, the Save CCHEZ2D Files options is available only when the
interface is in grid-editing mode. The Save CCHE2D Files option not only saves
the files that are required by the CCHE2D model but also generates a list file that
contains information needed to upload and download files for starting the
simulation and visualizing results respectively.
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Fig. 6.6 Active Setup Connection option
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The first step towards starting a simulation on the remote server is to login to the
server by selecting Setup Connection option under the Transfer Utility submenu.
As soon as the user selects the Setup Connection option, a window titled Setup
Connection to Server, as shown in Fig. 6.7, pops up. The user should provide the
User name and Password, provided by the NCCHE, in the appropriate field. If the
user is connecting to the server from within the NCCHE, the Connect to server
locally option must be selected. All other user must select the Connect to server
remotely option. After providing the necessary information and selecting the
appropriate option, the user should click the OK button. Any problems related to
establishing the connection to the server will be reported. If the connection is
successful, most of the options under Tranfer Utility submenu will become active.

Setup Connection to Serye El

|zer name

|
Pazzword

{* Connect to server remotely

" Connect to server locally

Cancel |

Fig. 6.7 Setup Connection to Server window
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Fig. 6.8 shows the Tranfer Utility submenu with all options active. The Setup
Connection option is check marked to show that the connection to the server
exists. The Save CCHEZ2D Files option is inactive showing that the files are saved
in the format required by the model. The user can upload and download files, start
a simulation, check the progress of a simulation that is currently underway on the
server, stop a simulation, or remove files from the server. The above-mentioned
operations can be performed for the case that is currently active in the CCHE2D-
GUL
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Fig. 6.8 Active transfer utility options

To upload the files, the user should select the Transfer Utility—> Upload Files
option or select the | button from the tool bar. The Upload Files option will be
available only if the files are saved in the appropriate format. The necessary files
related to the case currently displayed in the CAD window will be transferred to
the server. If the results files are present (both flow and sediment), these will be
uploaded too. The results files are needed if the user wants to restart the
simulation using the existing results. Uploading would fail if a case already exists
on the server. However, if the user needs to upload an updated version of the case,
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the existing case on the server must be deleted by selecting Transfer
Utility-> Remove Files From Server option.

Simulation Options x|

¥ Start flow Simulation

" Continue flow simulation

£~ Start/Continue zediment zimulation

Cancel |

Fig. 6.9 Simulation Options dialog box

Once the upload is complete, the user can start the simulation on the server. By
selecting Transfer Utility=>Start Simulation option, the user can reveal the
Simulaton Options dialog box to make appropriate simulation choice. The
Simulation Options dialog box is shown in Fig. 6.9. The Start flow simulation
options is selected by default. This option will start a new simulation. Any
previous flow results, i.e., both the intermediate flow results file and/or final flow
results file will be overwritten. The CCHE2D model simulation produces two
flow results files, one with a “.str” extension and the other with a “.mdw”
extension. The first file is a final flow solution file and the second is an
intermediate flow solution file that is written after certain number of time steps
specified by the user as described above. If a user chooses the Continue flow
simulation option, a file with a “.str” extension must be present, i.e., a flow
solution file must exist. If for some reason a final flow solution file is not
available, intermediate flow solution file can be saved as final solution file and the
simulation restarted. To accomplish this, the user must first download the files,
copy the file with a “.mdw” extension to a file with a “.str” extension, and then
upload the files. If the user chooses the Continue flow simulation option and the
final flow solution file is not present, an error will be reported. The last option,
Start/Continue sediment simulation, is related to the sediment simulation. In this
case the final flow solution file must be present and the sediment transport option
must be on otherwise an error message will be reported. This option can be used
to start a new sediment simulation, however, if a sediment solution (file with a
“.mds” extension) exists, it can be used to continue the sediment run. If a file with
a “.mds” extension exists, but the user want to start a new simulation for
sediment. The user should first download the files, delete the file with a “.mds”
extension, and then upload the remaining files to the server.
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During simulation, the user can check the progress by selecitng Transfer
Utility> Check Progress option or selecting the (3 button from the tool bar. A
dialog box will pop up showing the percentage of the simulation completed thus
far. The user can stop the simulation that is underway by selecting Transfer
Utility=> Stop Simulaton option.

The user can download the intermediate and final results file by selecting Transfer
Utility=> Download Files option or selecting the = ' button from the tool bar. The
final results file will be available only if the simulation has run to completeion.
During simulation, the selection of the above option will download the
intermediate file only. Also, if the simulaiton is forced to stop by the user, only
intermediate file can be downloaded. The user can view the most recent
intermediate or final results by selecting appropriate option under
FlowVisualization or SedimentVisualization menu. To remove the file uploaded
by the user and that produced during the simulaiton, the user should select
Transfer Utility=> Remove Files From Server option.



7 Visualizing the Computed Results

7.1 Introduction

Once the simulation is complete, the user may visualize any of the computed flow
and sediment results using the CCHE2D-GUI. The results are plotted in the form
of flood, line contours, or combination of the two. In addition, the user may plot
the velocity vectors (uniform or scaled) on top of any displayed quantity. The user
can change the size of the velocity vectors by using scaling factor and has total
control over the size and angle of the arrowheads. The user can skip I- and/or J-
lines to reduce the number of velocity vectors displayed. In addition, the mesh can
be plotted on top of any displayed quantity both in case of flow and sediment
results visualization. The user can probe the flow and sediment simulation results
at any node by using data probe tool. In case of visualizing flow results, the tool
may also be used to extract data along I- or J-line and save it to a file. When the
CCHE2D-GUI is in flow visualizing mode, the user can extract data along a
polyline described by the user or for a set of x- and y-coordinates specified in a
file.

The user can visualize flow results for final water surface level, two velocity
components, velocity magnitude, two specific discharge components, specific
discharge magnitude, bed shear components, and turbulent eddy viscosity. The
user can visualize sediment transport results for final bed topography, bed
elevation change for aggradation and degradation pattern. In addition, the user can
visualize the initial and final bed material composition for each of the size class.
The total and fractional sediment transport for both bedload and suspended
sediment can be also visualized.
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7.2 Visualizing Flow Results

Fig. 7.1 shows the FlowVisualization menu along with its submenu. The options
available under the FlowVisualization menu are Geometry File, Intermediate
Results File, and Final Results File. Nothing is available in the selection list box
as no file is loaded into the GUI. The options that may become available in the list
box depend on the type of file available for visualization. If there is no job or
project name available, the first step is to load a file by using the File—>Open
Geometry.option This displays the grid and the Show Grid File option under the
Grid menu becomes active. However, if a project name is already available, the
user may skip the above step. Once an option is selected under the
FlowVisualization menu, the CCHE2D-GUI goes into flow visualization mode. In
this mode, the user can work with the File, View, Style, and Data menus. The flow
visualization options are described in detail in the following section.
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Fig. 7.1 FlowVisualization menu
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7.2.1 Visualizing Geometry File
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The user should ensure that a project is open. Next, the user should select the
FlowVisualization—> Geometry File option to display the bed elevation in the
CAD window as shown in Fig. 7.2. A file with a “.geo” extension is loaded for
visualization. To display results in the form of flood, the user should make sure
that the Style=> Plot Type—> Flood option is selected.
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Fig. 7.2 Visualizing the geometry file

The Geometry File option under the FlowVisualization menu is check marked
showing the type of file that is being visualized. The quantity being visualized,
which in this case is initial bed elevation, is shown in the selection list box. The
title, which shows quantity being displayed along with its units, is shown in the
top left corner of the CAD window. The title can be turned on or off by selecting
the View—> Title option. A check mark is placed beside the Title option when it is
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on. The legend shows values associated with the colors and it can be displayed by
selecting the View—> Legend option. Only initial bed elevation option is available
in the selection list box as it is the only quantity available for visualization. The
Zoom and Pan options under the View menu are available. The user can turn the
grid on or off by using the options under the Style menu or by pressing the grid
toggle button (§). The options related to velocity vectors in the Style menu are
not active as velocity data is not available. The velocity vector toggle button ()
is also inactive. The FlowVisualization—>Geometry File option is useful to
visualize the bed elevation immediately after grid generation process.

By default the bed elevation is plotted as flood, however, the user can switch to
contour lines or both contour lines and flood by selecting appropriate option under
the Style=>Plot Type submenu. The user can also extract cross-sectional shape
data using the data probe tool for comparison with the surveyed sections.
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7.2.2 Visualizing Final Results File

As before, the user should ensure that a project name is available. Then the user
should select the FlowVisualization—>Final Results File option to display the
water surface level as shown in Fig. 7.3. In this case two files with “.geo” and
“.str” extensions are loaded.
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Fig. 7.3 Visualizing final results

The Final Results File option is check marked showing the type of file that is
being visualized. The quantity being visualized, which in this case is water
surface level, is shown in the selection list box. As before, the user can turn on the
title and legend for the displayed quantity. The user can visualize the results in the
form of flood, contour lines, or both contour lines and flood by selecting
appropriate option under the Style>Plot Type submenu. In this case, twelve
different quantities are available for visualization. The user can select any
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available quantity from the list box to visualize and use zoom and pan
capabilities, as described in section 2.3, to see the displayed quantity in further
detail.

The user can turn the grid or velocity vectors on or off by using the options under
the Style menu or the toggle buttons. By selecting the Style—> Vector Parameters
option the user may change the size and color of the vectors, density of the
displayed vectors, and size and angle of the arrowheads. In addition, the user can
select uniform or scaled velocity vector option for the displayed velocity vectors.

7.2.3 Visualizing Intermediate Results File

The FlowVisualization-> Intermediate Results File option displays the water
surface level. In this case two files with “.geo” and “.mdw” extensions are loaded.
The file with a “.mdw” extension contains intermediate results. This option can be
used to visualize the intermediate results as the model is running. The format of
the files having “.mdw” and “.str” extensions is exactly the same. The quantities
available for visualizing and other details are as described in section 7.2.2.



Chapter 7: Visualizing the Computed Results

7.2.4 Flow Data Probe
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The user can probe the flow simulation results by selecting the Data=> Data Probe
option or by pressing the data probe tool button from the tool bar (). A Flow
Probe window as shown in Fig. 7.4 will pop up to display the results for the
selected node. The results that can be probed at a node are x- and y-coordinates,
bed elevation, water surface level, x- and y-components of velocity, velocity
magnitude, x- and y-components of specific discharge, specific discharge
magnitude, x- and y-components of bed shear stress, bed shear magnitude, and

eddy viscosity.
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Fig. 7.4 Flow Probe window
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The user can probe the data at a node in three different ways. First by clicking the
node in the CAD window using the left mouse button. The user can select a node
by providing the I- and J-indices of a node in the appropriate fields under the
Probe using I and J indices option and then pressing the Probe button. Lastly, the
user can select a node by providing the x- and y-coordinates in the appropriate
fields under the Probe using x and y coordinates option and then pressing the
Probe button. The user can move the selection to next/previous node along an I-
or J-line by pressing the appropriate buttons at the bottom of the window. The
user can extract the data of all the nodes along an I- or J-line passing through the
currently selected node by pressing the Extract Along I Line or Extract Along J
Line button respectively. As soon as the user presses one of the above buttons, the
corresponding line passing through the selected node turns purple (whether the
grid is on or off) and a Save As dialog box pops up prompting the user to key in
the file name for saving the data. The file is appended with a “.dat” extension. The
file header contains the necessary information about the file format. The
highlighted I-line for data extraction is shown in Fig. 7.5, and the Save Extracted
Data As DAT File dialog box is shown in Fig. 7.6. The data extracted along an I-
or J-line is arranged in columns. Such a file can be easily opened in e.g.,
Microsoft Excel for plotting the data and comparing it with the measured results.
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Fig. 7.5 I-line highlighted for data extraction
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Fig. 7.6 Save As dialog box for saving the extracted data
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7.2.5 Extract Data

The interface can extract data at any point within the computational domain by
locating the cell within which the point lies and then interpolating the data on to
the point using the inverse distance interpolation. The user must provide the x-
and y-coordinates of the points at which the simulation results are desired in a file
with a “.fex” extension. The first line in such a file should contain one integer
value indicating the total number of points in the file. The subsequent lines should
contain two entries (both real values) of x- and y-coordinates. The file should be
saved as text file. If such a file exists, the user should select the Data—> Extract
Data option to display the Open a File for Data Extraction dialog box as shown
in Fig. 7.7. Only files with a “.fex” extension are available for selection. The user
should select the appropriate file and press the Open button. If any error is
encountered in the file, it will be reported. The extracted data will be saved in the
same file. The file format is explained in the file header. If any point is outside the
computational domain it will be reported in the file.

Open a File for Data Extraction 2=

Loak in: Ia HotophiaCreek: j & £ B9~

File name: | Open I
Filez of type: IData Estraction Files [*.fex) j Cancel |
S

Fig. 7.7 Open the file for data extraction
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7.2.6 Extract Data from Polyline

The user can extract data along an arbitrary line through the computational
domain. The line is defined by selecting points in the CAD window. In addition,
the user is allowed to specify the number of points for each segment of line
(between two consecutive points). These points are uniformly distributed between
the two end-points of a line segment.

Polyline for Data Exkr -~ il
| |hda I Save |
Undasll | Cancel |

Fig. 7.8 Polyline for Data Extraction window

To start describing a polyline, the user should select the Data=>Extract from
Polyline option to display the Polyline for Data Extraction window as shown in
Fig. 7.8. The user can start selecting points in the CAD window. The last selected
point is shown in white color while other points are shown in black color. A line
segments in black color is drawn to connect the two consecutive points. A
maximum of twenty points can be selected in the CAD window. The total number
of points at which the data will be extracted will depend on the number of points
that the user specified for each line segment. The selected points must lie within
the computational domain. If a point is not within the computational domain, a
dialog box will pop up to report the error.

The first point selected in the CAD window will be highlighted in white color. As
soon as the user selects the second point, the first point turns to black and the
second point is highlighted in white color and the two points are joined together
by a line segment. Also, the Assign Value window pops up prompting the user to
specify number of points between the current and the last point. The user should
key in the desired value and press the OK button. The Assign Value window and
the CAD window showing the points joined together by a line segment are shown
in Fig. 7.9. The user can add more points by following the procedure outlined
above. To remove the last clicked point, the user should press Undo button in the
Polyline for Data Extraction window. To remove all the points, the user should
press Undo All button. To extract and save the data to a file, the user should press
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the Save button to display the Save Data Extracted From Polyline As dialog box.
The user should type in the file name and the data will be saved to that file. The
file name is appended with a “.pex” extension. The file header provides
information about the file format. If a point does not coincide with a node in the
grid, the simulation results are interpolated as described above.
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Fig. 7.9 Procedure for specify polyline
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7.3 Visualizing Sediment Results

Fig. 7.10 shows the SedimentVisualization menu along with its submenu. The
options available as a first set under the SedimentVisualization menu are
Intermediate Results File and Final Results File. In the first case two files with
“.geo” and “.mds” extensions are loaded, while in the second case files with
“.geo” and “.sts” extensions are loaded. The Select Size Class for Display option
is not available as no file is loaded for sediment visualization. Even if a file is
loaded for the sediment visualization, the Select Size Class for Display option is
available only if non-uniform sediment transport is simulated. As no file is loaded
into the GUI, the selection list box displays “Nothing to Select”.

If there is no job or project name available, the first step is to load a file by using
the File=>Open Geometry.option This displays the grid and the Show Grid File
option under the Grid menu becomes active. However, if a project name is
already available, the user may skip the above step. Once one of the two options
in the first set under SedimentVisualization menu is selected, the CCHE2D-GUI
goes into sediment visualization mode. In this mode, the user can work with File,
View, and Style menus. Also, the Data Probe option under the Data menu is
available to the user. As before the display options under sediment visualization
mode are provided in the selection list box..

E:Nu File Selected - CCHEZD-GUI -0l x|
File Edit Grid AssignBC  Wiew 3Stvle Data  Flowvisualization | SedimentWisualization  Help
O = | | =) | 7 ||Nc|thingto Salact Intermediate Results File | ﬁ | T | 11 I:I|

Final Results File

Select Size Class For Displa...

[ Y

Fig. 7.10 SedimentVisualization menu
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Fig. 7.11 Visualizing final bed material composition

Fig. 7.11 shows the sediment result file loaded into the CCHE2D-GUI. The list
box in the tool bar shows the display options available. The display options in the
list box will depend both on the transport mode selected and whether the sediment
are uniform or non-uniform. The bed load transport options are not available as
the simulation was performed with suspended sediment transport only. The figure
shows the final bed material composition being displayed for the first size class.
To visualize results for any other size class, the user should select the
SedimentVisualization—> Select Size Class for Display option to display the Select
Size Class for Display window as shown in Fig. 7.12. There are total of nine size
classes as shown in the dialog box. The current slider position, which corresponds

to the size class displayed, is also shown in the window.

Select Size Class for Display

Fig. 7.12 Size class selection
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The user can select any size class by moving the slider in the Select Size Class for
Display window back and forth. As the slider is moved, the image in the CAD
window is updated to show the results corresponding to current size class. Press
the Exit button to remove the Select Size Class for Display window. The Select
Size Class for Display window is available for the [nitial Bed Material
Composition, Final Bed Material Composition, Fractional Bedload Transport
Rate, and Fractional Suspended Load Concentration options in the
SedimentVisualization menu.

The user can add grid on top of the visualized quantity and can use zoom and pan
to view the results in details. The user can visualize the initial bed level, final bed
level, and bed level change to view aggradation/degradation pattern. In addition,
the user can visualize the final median diameter distribution of bed material.
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7.3.1 Sediment Data Probe

The user can probe the sediment simulation results by selecting the Data—> Data
Probe option or by pressing the data probe tool button from the tool bar (). A
Sediment Probe window as shown in Fig. 7.13 will pop up to display the resutls
for the selected node. The results that can be probed are x- and y-coordinates,
initial bed elevation, final bed elevation, bed transport rate (if applicable),
suspended sediment concentration (if applicable), and final median size The final
median size in case of uniform sediment show the actual sediment size.

Initial bed elesvatiorn [m] IEI.EI4EEIEIDEI¢1 Final bed elevation [m] IEI.EI#E'I 92008
Bed tranzport [kgz/m] IEI Suzp. concen. [kgdne] IEI.EI'I 0316
Final median zize [m] II:I.EIEIEE1 599

Fractional Properties

[H#] [Int. Bed Comp.] [Fin. Bed Comp.] [Bedload Tran] [Susp. Concent.] =
1 0.071520000 0.11209400 000000000 000723973

2 002700000 0.111 30600 000000000 000213146

3 0.03730000 011111200 000000000 000092178

4 003740000 0.11097500 000000000 000027739

4] 00551 0000 0.11091200 Q00000000 0.0001 0926

B 011930000 0.11030000 000000000 000002582

7 0.1811 0000 0.11030000 000000000 0.00000000

a 021020000 0.11030000 000000000 0.00000000 e
q 031230000 0.11030000 000000000 0.00000000 -
Kl 3
—Probe uzing | and J indices———— —~ Probe uzing & and v coordinates

| index I3 # coordinate [m) I22
J index I23 y coordinate [m] 015

Frobe | Frobe |
Mest | I Previous | | E strract Alogn | Line |

MHext | Presviouz J | Eutract Along J Line |

E wit |

Fig. 7.13 Sediment Probe window
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The user can select the point for data probe in three different ways as described
for flow data probe. In addition, the user can move the probe point to the
next/previous I- or J-node by pressing the appropriate button provided at the
bottom of the Sediment Probe window. The Fractional Properties edit box
available only for non-uniform sediment show the initial and final bed
composition and fractional bedload and sediment concentration for each size
class.

The user can extract the data, as described for flow data probe, along an I- or J-
line passing through the currently selected node by pressing the Extract Along 1
Line or Extract Along J Line button respectively. In addition, the user can extract
the data for a given set of x- and y-coordinates provided in a file. The user can
also extract data along an arbitrary line. The procedure for extracting data for the
data points provided in a file and for points along a polyline is as described in
sections 7.2.5 and 7.2.6.

7.4 Contour Lines and Flood

In grid editing mode, i.e., when the GUI is in the grid display mode and the Show
Grid File option under the Grid menu is check marked, the user can visualize the
available variables as flood only. However, in flow or sediment visualization
mode, the user can display the results in the form of flood, contour lines, or both
flood and contour lines by selecting Flood, Lines, or Lines and Flood option
respectively under the Style=> Plot Type submenu. The user can specify maximum
and minimum value both for the flood and contour lines. The user can choose
shaded color or color contour option for flood. If color contour option is selected
for flood, the user can also specify the number of color contours. In case contour
lines are displayed, the user can change the number of contours or contour
interval and label the contours. The user can add the domain boundary by
selecting the Style=> Boundary option.

The user can visualize the results in color scale or gray scale. By default the red
color is assigned to the maximum value of the variable (white in case of gray
scale) and blue to the minimum (black in gray scale), however, the user can
reverse the color map.
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7.4.1 Setting Parameters for the Flood Option

The user should select Flood or Lines and Flood option under the Style—> Plot
Type submenu to visualize the results as flood. In the grid display mode Flood is
the only option availabe to the user and is selected by default. The default option
for flood is color shading, i.e., the colors at the vertices of the mesh is interpolated
in the interior of the cell. An example of color shading for flood is shown in Fig.
7.14. In case of color shading, the legend shows five distinct colors with color
shading in each square.

. hoto - CCHE2D-GUT
File Grid AssignEC VWiew Style Data FlowVisugdlization SedimentVisualization Help

D& | & 7 ||water Surface Level =+ F o0 OFEE BE| T L1 l:l|
Water Surface Level (m) | I D — |
62.457 02,858 63.250 63.650 fi4.060

eady , ¥, ¥, war = X G ; i
Read 1,3, % v 39, 126, B41.076294, 3604 751221, 62,500000 7

Fig. 7.14 Flood as color shading



Chapter 7: Visualizing the Computed Results

Flood Properties x|

% Flood using color shading

" Flood using color contours

Mumber of comtours |1 o

Oniginal Scale——— — Cunrent Scale

kirirnm IEE.#E?S? kiFirnm IEE.#E?E?
b &=irmumn IE#.DEEIEE bl a=irnumn IE#.DEEIEE

Fezet Scale |
Cancel_|

Fig. 7.15 Flood properties dialogn box with color shading option

Flood Properties x|
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Fig. 7.16 Flood properties dialogn box with color contours option
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To change the option, the user should select Style=> Flood Properties to display
the Flood Properties dialog box as shown in Fig. 7.15. The dialog box shows the
Flood using color shading option selected for the flood. In the dialog box both the
original scale and the current scale are also shown, which in this case are the
same. The user should type in the new values for the maximum and/or minimum
values under the Current Scale option. This option is useful if the user wants to
compare simulation results of the same case under different parameter values. To
reset the flood scale to the original values, the user should select the Reset Scale
option. To implement the new options selected, the user should press the OK
button.

To plot flood as color contours, the user should select the Flood using color
Contours option. The Number of contours text box will bcome active. Fig. 7.16
shows the color contours option selected. The user can type the number of color
contours desired. An example of color contours for flood is shown in Fig. 7.17. In
this case the legend represents nine distinct color intervals corresponding to ten
contours selected.

&hoto - CCHEZD-GUI 0 ] 53
File Grid AssignBC  Wiew Style Data  Flowvisualization  Sediment¥isualization  Help
b=zHE & % ||Water8urfaceLevel j|+| 4 s D|E|T|L_~llﬂ|
Water Surface Level (m) ] [ ]

Ready

TE— I I
62457 62635 62.813 62002 63170 63348 63526 63704 63.882 o64.060

[[, 3, %, v, var = 39, 101, 701,603650, 3472, 175537, 63.751500 4

Fig. 7.17 Flood as color contours
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By default the Style=>Color Scale option is check marked, i.e., the color as
opposed to gray scale is used to visualize the results. Select the Style—> Gray Scale
option to visualize the results in gray scale as shown in Fig. 7.18.

: hoto - CCHE2D-GUI

File iGrid AssignBC Yiew Style Data  Flowvisualization Sedimentvisualization Help
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Ready
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Fig. 7.18 Visualizing results in gray scale
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By default, the black color represents minimum value and the white the maximum
value of the variable when gray scale is selected. In case of color scale, maximum
value is represented by red color and blue color represents the minimum value.
However, the user can reverse the color map by selecting the Style—>Reverse
Color Map option. The option is check marked to show that the color map is
reversed. By selecting the option again, the user can set the color map to default
setting and the check mark beside the option will disappear. Fig. 7.19 show results
displayed in gray scale with color map reveresed.

i

File Grid AssignBC  View Style Data  Flowvisualization  SedimentVisualization  Help
0w M| & R ||water surface Level Bl |00 D|E|T|L_ll]|
Water Surface Lewvel (m)

[
6246 6286 6326 6366 6408

Ready [l 3, % v, var = 1, 1, 167, 136108, G767,589600, 62,932350 4

Fig. 7.19 Results visualized with color map reversed
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7.4.2 Setting Parameters for Contour Lines

The option of visualizing the results in the form of contour lines is available only
if the interface is in flow or sediment results visualization mode. The user should
select Lines or Lines and Flood option under the Style=> Plot Type submenu to
display the visualized results in the form of contour lines. If the Lines option is
selected, it may be necessary to add the domain boundary. The user can add the
boundary of the domain by selecting the Style—> Boundary option.

21 hoto - CCHEZD-GUI P ]
File Grid AssignBC  View Style Data  Flowvisualization  SedimentVisualization  Help
O E (& 2 [[initial Bed Elevation Al oo COFERBE T L 1o
[nitial Bed Elevation (o)

Ready I, 1, %, v, var = 1, 1, 167, 136108, 3787,589600, 64, 160400
%

Fig. 7.20 Contour lines with domain boundary

Fig. 7.20 shows visualization of initial bed elevation with contour lines only. The
boundary of the domain is also drawn. Fig. 7.21 displays results that have both
lines and flood.
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1 hoto - CCHE2D-GUI
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Fig. 7.21 Contour lines and flood
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To change contour lines characteristics, such as line color, number of contour
lines, contour interval, or maximum and minimum values for the contours, the
user should select the Style=> Contour Properties option to display the Contour
Lines Properties window as shown in Fig. 7.22. The window displays the original
and current maximum and minimum values of the variable being displayed. The
user can change these values for the variable being displayed. The two option at
the top relate to calculating the number of contours and contour interval based on
the current maximum and minimum values. If the option Contour lines based on
min, max, and number of contours, as shown in Fig. 7.22, is selected, the field that
allows the user to enter the number of contours is active. The user can input the
number of contours desired and the contour interval will be calculated based on
the current maximum and minimum values and the number of contours. If the
Contour lines based on min, max, and contour interval is selected, the field
related to contour interval is activated and the user can input the contour interval
desired. In this case, the number of contours are calculated based on the
maximum and minimum values and the contour interval. Thus manipulating the
maximum and minimum values and either the number of contour lines or contour
interval the user can plot the desired contours. The user can reset the current scale
to the original scale by pressing the Reset Scale button.

Contour Lines Properties il

= Contour ines bazed on min, max, and number of contours

™ Contour ines bazed on min, max, and contour intersval

Original Scale——— Current Scale

b irninnLarn |52.45?3? MirirrLir |52.45?3?
b axirnum |54-|:|5955 b airnum IE#.DEEIEE

Mumber of contours |1 1] Feset Scale |
Caontaur intersal IU-1 FB0566EEE Set Contours Colar |
cocet_|

Fig. 7.22 Setting the contour lines properties
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Fig. 7.23 Color dialog box with basic colors
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Fig. 7.24 Color dialog box with custom color selection

110



Chapter 7: Visualizing the Computed Results 111

The user can choose the color for the contour lines by clicking the Set Contour
Color button. A Color dialog box, as shown in Fig. 7.23, will pop up for choosing
contour lines color. The user can select any of the basic colors by clicking in the
appropriate color box. To apply the selected color, the user should press the OK
button. To choose a custom color, the user should click the Define Custom Colors
option in the Color dialog box to reveal the panel to the right as shown in Fig.
7.24. The currently selected color is shown in the Color/Solid box. By adjusting
the cross-hair tool in the rectangular window and the vertical slider provided at
the right edge, the user can choose a color for the velocity colors. Click on the OK
button to apply the selected color to the contour lines.
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Contour Y alue

_ Addlabel |
F3.34765333
B2 45737000 ﬂ Femove Label |
F2 E3542EE7
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E3 TOITEEET — Set font size and significant digit——
Eiggéggggg Fant zcaling Factar |1—
Sigificant digits [3
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— Fotation

¥ Font background

IEI
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and negative clockwize
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Fig. 7.25 Adding and removing labels

The user can label the contours by selecting the Style—> Label Contours option. A
Label Contours window, as shown in Fig. 7.25, will pop up allowing the user to
add and remove the contour labels. To add a label, the user must first select the
contour value from the list of the available contours. The selected contour will be
highlighted in the CAD window in purple color. Next, the user should click the
Add Label button. The title of the window will show the current mode which is to
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add label for the selected contour. The user can set the number of significant
digits displayed in the labels and the font size by supplying appropriate values for
the Significant digits and Font scaling factor edit boxes and then pressing the Set
button. The user can select the font color by clicking the Set Font Color button. A
Color dialog box will appear that can be used to select font color as described
above for selcting contour lines color. To add white background to the label, the
user should click in the box to the left of Font background option. A check mark
in the box shows that white background will be added to the label.

Xl
Contour W alue 4dd Label |
E2.81348333
R Label
B2 45737000 ] _Remove Lbe |
E2 E30426E7
E2.81348333 Remove Al |
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£3.169R9EE7 Clear Al |
£3.347ER333
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— Rotation
¥ Font background
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and negative clockwize
set Edt |

Fig. 7.26 Adding label to the selected contour

Fig. 7.26 shows a contour selected from the available contours list. The selected
contour value is highlighted and its value reported in the Contour Value field. The
selected contour is highlighted in the CAD window. To add a label, just click at
the dersired location in the CAD window. The user can set the angle by providing
a value in the field under the Rotation option and then pressing the Sez button.The
current label and all the labels added from that point onward will be rotated by
that value. In the Label Contours window shown above, the font color is black
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with white background. The label will be rotated 15 degrees in counterclockwise
direction. The highlighted contour with a label added is shown in Fig. 7.27.
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Fig. 7.27 Highlighted contour with label added

The user can add multiple labels for the same contour. To add another label, the
user should click at the desired location in the CAD window. To add label for
another contour, first select the contour value from the list and then repeat the
process outlined above. To remove a label, first select the contour value from the
list and then press the Remove Label button. The title of the window will display
the option selected. The user can remove a label by clicking on it in the CAD
window. To remove another label, just click near that label in the CAD window.
Thus, the user can remove multiple labels for the selected contour. To remove all
the labels for the selected contour, the user should select Remove All button. To
clear the labels for all the contours, the user should select the Clear All button.
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7.5 Velocity Vector Parameters
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Fig. 7.28 Vector Parameters window

In order to change the size, density, and color of the vectors and/or to change the
length and angle of the arrowheads, the user should select the Style—> Vector
Parameters option to access the Vector Parameters window as shown in Fig.
7.28. The Style—>Vector Parameters option is available only if the velocity
vectors are on. The user can use the options available in the window to control the
size and color of the vectors, size and angle of the arrowheads, and density of the
velocity vectors. In addition, the user can either select the Scale vectors to velocity
or Uniform vector size option. By default the vectors are scaled to velocity
magnitude.

The Scale factor (<= 1 or > 1) parameter is used to increase or reduce the length
of the vectors. The original length of the vectors is multiplied by the scale factor
to arrive at the new length. The Line thickness parameter is used to increase or
reduce the thickness of the arrows and arrowheads. The density of the velocity
vectors can be reduced by specifying values for the Number of I lines to be
skipped and Number of J lines to be skipped parameters other than zero. A value
of 1, e.g., for the Number of I lines to be skipped parameter will omit velocity
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voctors for evey other I-line. The Arrow head length (% of length) parameter can
be used to increase or reduce the length of the arrow heads. The Arrow head angle
(degrees) parameter is the angle measured from the arrow body. For example, a
value of 90 degrees would set the arrow heads at right angle to the arrow body. A

sample plot of velocity vectors overlayed on color scaled contours is shown in
Fig. 7.29.
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Fig. 7.29 Displaying velcocity vectors

To change the color of the velocity vectors, the user should click the Set Vector
Color button in the Vector Parameters window. A Color dialog box, as described
above, will pop up for selecting the vector colors.
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7.6 Opening a New File with Current Settings

The user can open a new results file (flow or sediment depending on what is
displayed currently) with the current setting by selecting File—> Open File with
Current Settings to display the Results Settings dialog box as shown in Fig. 7.30.
The user can keep the current view coodinates, the flood scale settings, and
contour scale settings for the new geometry file.

Results Settings X|

[ Keep flood scale settings
[ Keep contour scale settings

[ Keep view coordinates

Fig. 7.30 Options for selecting the setting to keep

If the user keeps the view coordinates, the new file will be opened with the
current view coordinates. If the image is not visible, the minimum and maximum
coordinates of the new case are out of the view range. In that case, the user can
display the new image by selecting View—>Fit to Full Size option or the
corresponding tool in the tool bar. If the user chooses to keep the flood scale, the
current maximum and minimum values of the flood scale of all the variables will
be kept for the new image. To reset the flood scale, for the currently displayed
variable, to the actual maximum and minimum values, the user should select
Style=> Reset Flood Scale. If the user selects to keep the contour scale, the current
maximum and minimum values of the contours scale of all the variable will be
kept for the new image. To reset the contour scale, the user should select
Style> Contour properties option and then reset the contour scale.
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Fig. 7.31 Opening a geometry file

Once the user press the OK button, an Open a Geometry File dialog box, as
shown in Fig. 7.31, will pop up for geometry file selection. To cancel the action
of opening a new file, the user should press the Cancel button. Once the geometry
file is selected, the interface will open the correponding results file and display the
image or display an error message if the results file cannot be found.



8 Legend, Title, Text, and Background Color

8.1 Introduction

The user can add legend, title, and text at any stage for any visualized quantity
whether the interface is in grid, flow, or sediment display mode. The legend and
title options are not available when the interface is in grid display mode and Grid
Only option under the Grid menu is selected. The user can pan and set font size
for the title. The user can pan, set font size and color, and rotate the text added in
the CAD window. The user can also pan legend and set height, width, font size,
significant digits for labels, and orientation of the legend. In addition, the user can
change the background color of the CAD window under any mode.

8.2 Legend

To add legend, the user should select the View—>Legend option. The option is
check marked to show that legend is added. To move the legend, the user should
select the View—>Pan Legend option, a check mark is placed beside the option to
show that the option is turned on and the right mouse key will be associated with
moving the legend around. To remove the legend, select the View—>Legend
option. The legend will disappear along with the check mark beside the option.

To pan the legend, first select the View—>Pan Legend option, next click at a
reference point by pressing the rigth mouse button. Keeping the right mouse
button depressed move the mouse to the position that the user wants to translate
the reference point to and release the right mouse button. As the mouse is moved
with its right button depressed, a line is drawn and updated continuously from the
starting point to the new position. Release the right mouse button at the final
position and the reference point will be translated to the final point where the right
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mouse button was released. The legend can be moved within the CAD window
only, i.e., the legend cannot be panned completely out of the viewing area.

8.2.1 Setting Legend Properties

To set legend properties, such as its height, width, label font size and number of
significant digits, and orientation, the user should select the View—>Legend
Properties to reveal the Legend Properties window as shown in Fig. 8.1. The user
can set the orientation of the legend as horizontal or vertical by using options
under Orientation. The width and height of the legend as percent of the screen
width and height can be set for the legend. In addition, the user can set the font
size and the number of significant digits for the legend’s label.

Legend Properties x|

rientatian
|VF Horizantal = Wertical

Width [% of screenwidth) [0
Height [% of zcreen height) |25—
Font zize IM—
Sleplieat Lalie E
Caticel |

Fig. 8.1 Setting legend properties
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8.3 Adding Title

The user can add title by selecting the View—> Title option. A check mark is placed
beside the option to show that the title is added. The title shows the name of the
quantitly displayed along with its units. In case of non-uniform sediment
transport, the title also shows the size class being viewed. The title cannot be
edited, however, the user can pan the title to the desired location by selecting the
View->Pan Title option and following the procedure explained for panning the
legend. In addition, the user can set title font by first selecting the View—> Title
Properties option to display the Title Properties window and then providing the
value for the font size. The Title Propeties window is shown in Fig. 8.2. To
remove the title, the user should select the View—>Title option. The title will
disappear along with the check mark beside the option.

X

Title Properties

Faont size I1 4
cace_|

Fig. 8.2 Setting font for the title
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8.4 Adding Text

To add or modify the text, the user should select the View—> Text option or T
button in the tool bar to reveal the Add/Modify Text window as shown in Fig. 8.3.
If there are any text strings present in the CAD window, it will be shown in the
list box provided in the Add/Modify Text window. The first text string will be
highlighted in the list box and will be shown in the Text box. The selected text
string will be bounded by vertical lines in the CAD window. If there are no text
strings present, the list box in the Add/Modify Text window will be empty. The
user can add mulitiple text strings in the CAD window. Each text string can only
be one line long, i.e., multiline text strings are not available. The user can replace
the selected text string with a new text, delete the selected text string, or remove
all text strings in the CAD window. In addition, the user can pan the selected text
string, change its font size and color, and rotate it.

Add/Modify Text x|
Text
|
=] Add Test |
Feplace Text |
Delete Tesxt |
Clear &l |
_ILI Text Calor |
K| 3
Parn Tesxt |
— Font Scale and B atation
Font zzaling factor I2
Set | Bt |
Ratation [degreez) IEI

Fig. 8.3 Adding/Modify Text window
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To add a text string, the user should provide the text in the 7ext box and press the
add button. The text is added in the list box provided below the Text box and
highlighted to show the currently selected text string. To enter another text, repeat
the above process. Fig. 8.4 shows the Add/Modify Text window with three text
strings added. The most recent text string added is highlighted. However, the user
can select any text string in the list box by clicking on it. The selected text string
in the list box will be highlighted and the Text box will be updated to show the
selected string. In addition, the selected text string will be preceded and followed
by a vertical line in the CAD window. In Fig. 8.4, the second text string is
selected in the list bar.

Add/Modify Text

Text
IBEd E leweation

|H|:|t|:|§hia Creek, 4| Add Tesxt

Puoint B ar

Elelefl |

Replace Text
Delete Text
Clear &l
LI Llj Text Color

Pan Tesxt

— Font Scale and Faotation

Fort scaling factar |2

I Set | Exit
Ta—

Fiotation [degrees] |0

Fig. 8.4 Adding text strings

To replace an existing string with new text, the user should first select the text
string in the list box that need to be replaced or modified. Next, key in the new
text in the Text box and then press the Replace Text button. The text string in the
CAD window will be replaced with the new text. However, the font size, color,
and its orientation will be maintained. To remove a text string, first select the text
string in the list box and then press the Delete Text button. The selected text string
will be deleted and the following text string will be highlighted and shown in the
Text box. To remove all the text strings from the CAD window, just press the
Clear All button in the Add/Modify Text window.
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The user can change the font size and orientation of the selected text string by
keying in appropriate values in the Font scaling factor and Rotation (degrees) edit
boxes and then pressing the Sef button. By default the scaling factor for font size
is set to 2.0 and the rotation is set to zero, i.e., the text will be oriented
horizontally. A positive angle will rotate the selected text string in counter
clockwise direction while a negative angle will rotate it in clockwise direction.

The user can change the color of the selected text string by clicking the Text
Color button in the Add/Modify Text window. A Color dialog box will pop up
allowing the user to select the text string color. The details of how to select a
color in the Color dialog box are provided in section 8.5.

To pan the selected text, first click the Pan Text button in the Add/Modify Text
window and then using the right mouse button click at a reference point in the
CAD window. Keeping the right mouse button depressed move the mouse to the
position that the user wants to translate the reference point to and release the right
mouse button. As the mouse is moved with its right button depressed, a line is
drawn and updated continuously from the starting point to the new position.
Release the right mouse button at the final position and the reference point will be
translated to the final point where the right mouse button was released. The text
string can be panned only within the window, i.e., it cannot be panned completely
out of the window.
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8.5 Background Color

The default background color of the CAD window is white, however, the user can
change the background color by selecting the appropriate color in the Color
dialog box that can be accessed by selecting the Style—> Background Color option.
The Color dialog box is shown in Fig. 8.5. The user can select one of the basic
color as the background color or click the Define Custom Colors option for
custom color selection.
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Fig. 8.5 Color dialog box
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Fig. 8.6 Color dialog box with custom color selection revealed

Fig. 8.6 shows the Color dialog box with Define Custom Colors option selected.
The currently selected color is shown in the Color/Solid box. The user can change
the color by moving the slider, provided at the right edge, vertically up or down,
and by moving the cross-hair tool in the square window to the left of the slider.
The user should press the OK button to apply the newly selected color as the
background color. The printed image will also show the current background color.
In addition, the exported bitmap image and the layout will preserve the
background color information.



